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ECDL Online Essentials 

 

With a growing reliance on the Internet for work, communication and recreational needs, 

keeping up-to-date with online tools and knowing how to use them effectively is a crucial 

component of digital literacy. ECDL Online Essentials will guide you through the key skills to 

get you working and engaging securely in online activities, such as web browsing, social 

media, and e-mail.  

  

ECDL Online Essentials establishes core concepts and skills relating to web browsing, 

effective information search, online communication and e-mail. Having completed this 

module you will be able to: 

 Understand web browsing and online security concepts. 

 Use the web browser and manage browser settings, bookmarks, and web 

outputs. 

 Search effectively for online information and critically evaluate web content. 

 Understand key copyright and data protection issues. 

 Understand concepts of online communities, communications and e-mail. 

 Send, receive e-mails and manage e-mail settings. 

 Organise and search e-mails and use calendars. 

  

What are the benefits of this module? 

Knowing how to operate and get the most from web browsers is a vital digital literacy skill 

that is essential in work and at home. This module also teaches you about online security, 

keeping your personal information private, avoiding phishing scams, and using e-mail 

effectively. Once you have developed the skills and knowledge set out in this book, you will 

be in a position to become certified in an international standard in this area - ECDL Online 

Essentials  

 

For details of the specific areas of the ECDL Online Essentials syllabus covered in each 

section of this book, refer to the ECDL Online Essentials syllabus map at the end of the 

book.  
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LESSON 1 -  

GETTING STARTED  

In this section, you will learn how to: 

 

 Understand and connect to the Internet 

 Identify popular browsers  

 Start and close a browser  

 Recognise part of a web address  

 Use browser features  
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1.1 UNDERSTAND THE INTERNET 

 Concepts 

The Internet is a world-wide system of interconnected computer networks linking 
billions of devices. It consists of millions of private, public, academic, business, 
and government networks, connected by a wide range of electronic, wireless, and 
optical networking technologies.  

 

The terms Internet and the World Wide Web (or just Web) are often used 
interchangeably. However, the Internet provides many other services, including 
the inter-linked hypertext documents and applications of the Web, electronic mail, 
instant messaging, and telephony. 

 

1.2 CONNECTING TO THE INTERNET 

 Concepts 

All modern computers and laptops, as well as many other devices, such as tablets 

and smart phones, are capable of connecting to the Internet.  A common way of 

connecting to the Internet is through a telephone line, which can carry normal 

phone calls and Internet data at the same time. Alternatively, you can connect to 

the Internet by using a service from a mobile network providers. This can be used 

anywhere there is a mobile signal but can be slower and more expensive than 

connecting through a landline.  

 

A connection with the Internet is typically made using an Internet Service Provider 

(ISP). Comparison sites are a good starting point to quickly identify which ISPs 

have the best combination of speeds and price. You'll also need to visit the 

individual ISPs' websites to get the fine details on their packages so you can make 

a thorough comparison for yourself, based on your needs. In particular, pay 

attention to: 

 

Download and Upload Speeds 

We all want the fastest internet at the price we're willing to pay. Make sure when 

you're comparing services you compare the most similar plans based on both 

download and upload speeds. Bandwidth is measured in bits per seconds (bps). 

As you might guess, this is the number of single bits that can be transferred 

across a network connection in one second. Although similar to file size 

measurements, they are calculated slightly differently. 
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1.3 WEB BROWSING CONCEPTS 

 Concepts 

 

Uniform Resource Locator (URL) 

URL stands for Uniform Resource Locator (another name for web address / 

website address) The URL consists of the name of the protocol (usually HTTP); 

followed by the name of the website you want to connect to. 

 

Hyperlink 

A hyperlink is a piece of text or a picture on a web page that when clicked will 

automatically do one of the following: 

 

1. Take you to a different part on the same page. 

2. Take you to a different page within the web site. 

3. Take you to a page in a different web site. 

4. Enable you to download a file. 

5. Launch an application, video or sound. 

 

If a piece of text or a picture is a hyperlink, when you point to it with your mouse, 

the mouse pointer will change into the shape of a hand. 

 

TIP: Hyperlink text is usually blue and underlined. 

 

1.4 UNDERSTAND THE STRUCTURE OF A WEB 

ADDRESS 

 Concepts 

Every web page has its unique address that we use to find it. This address is 

called a Uniform Resource Locator, or URL. 
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Consider the URL displayed in the address bar above. The following table shows 

you what the different parts of the URL mean. 

 

http://www.icdl.org 

http:// www. icdl .org 

Hypertext 
transfer protocol 

World Wide Web Site name Domain name 

This part tells 
the computer 
how to send 
information to 
and from your 
computer 

 This is the 
name of the 
web site on 
your screen 

This tells you the 
type of web site 
and sometimes 
the country it 
comes from 

 

 
Don’t worry if the URL is long and hard to understand. You don’t have to 

remember it! 

 

 The following is a list of the most common domains types: 

 

.com (commercial site) 

 

 

 

.edu (educational / 

institution) 

 

 

 

.gov (government site) 

 

 

 

.net(network site) 

 

 

 

.org (non-profit or private 

organisation) 

 

 

.it (geographical site with 

a two letter identifier 

listing where the site is 

registered)  

 

 

 

http://www/
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1.5 BROWSING   

 Concepts 

A web browser is a software program that allows you to browse the Web by 

simple point and click navigation. Examples of web browsers include Internet 

Explorer, Mozilla Firefox, and Google Chrome.  

There are a huge range of activities that you can carry out on the Web by using a 

browser. These include: 

 

Information Searching 

People browse the Web for information, often using search engine such as 

Google or Yahoo to identify specific topics that are of interest to them. 

 

Entertainment 

The Internet provides many opportunities to access entertainment. You can 

stream videos, playing games with people on the other side of the world, or listen 

to music. Increasingly, all forms of entertainment are available online.   

 

Communication 

Communication is another way to use Internet. People connect via each other 

through various IM services like Skype and Yahoo messenger, and can use 

Internet telephony and video services to interact with people irrespective of their 

location – often for free! 

 

Shopping – E-Commerce 

Increasingly people are purchasing directly from Web sites, such as Amazon.com.  

Most Web-based shopping sites use a virtual “shopping cart” system. As you 

browse the site you can add any products you want to purchase to your cart. 

Once you have placed items in the cart you can then move to the checkout stage. 

At the checkout you enter your name and address, select the type of delivery you 

want and enter your payment details. 

 

Learning 

E-learning refers to learning on a computer or device, often over the Internet. One 

trainer can train many students at different locations. Students may be able to 

work at their own pace, and repeat parts of a course which they do not 

understand. Also the teaching can be at any time, 24 hours a day, and 7 days a 

week.  
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Publishing 

The Web provides a range of often low-cost opportunities to publish different 

types of content. For example, you can publish information on web pages or even 

a book that can be made available through online book stores.  

 

Banking 

More and more financial institutions give their customers access to a range of 

services online, such a paying a bill or transferring funds between accounts. This 

gives people much more flexibility because they are not restricted by the opening 

hours of a bank branch.  

 

Government services 

E-government (short for electronic government) refers to the use of technology to 

provide and improve government services, transactions and interactions with 

citizens and businesses, and within the government. 

  Steps 

In this book, we will focus on the Microsoft Internet Explorer 10 browser. The 

following are steps to open a web browser. 

Steps Practice Data 

1.  Click the Start Button and 

select All Programs. 

The list of applications 

available appears. 

Click and select All Programs. 

 

2. Select Internet Explorer. 

The Internet Explorer window 

will appear.  

Click & open Internet Explorer. 

 

3. Enter a URL in the address bar 

and go to the URL. 

The webpage will load once 

you press enter. 

 

4. Close the web browser. 

The web browser will close.  

Click on the close icon in the title bar. 
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1.6 USE AVAILABLE HELP FUNCTIONS  

 Concepts 

As with most applications, Internet Explorer has a built-in support feature. To 

use Help, simply click on the Help menu in the main view. Then choose Internet 

Explorer Help. 

 

The Help window will be displayed as illustrated: 

 

Internet Explorer Help Function 

 

Select one of the available help topics, or click on the Search Box to search for 

a topic by entering a keyword. 

 

Tip: To open up the Help dialogue box you can hit the F1 button.  
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1.7 DISPLAY, HIDE BUILT-IN TOOLBARS. RESTORE, 

MINIMISE THE RIBBON  

 Concepts 

Internet Explorer’s user interface is customisable, allowing you to edit the toolbar 

buttons and title bar text to your personal preference.  

  Steps 

Click View, and then choose Toolbars. 

 The menu that appears will show you the available toolbars in your web 

browser. 

 The toolbars that are currently switched on are marked with a tick on 

the left hand side. 

 You can toggle between displaying and hiding toolbars by clicking on 

them. 

 

 

Minimise the Ribbon  

 To quickly minimise the Ribbon, double-click the name of the active 

tab. Double-click a tab again to restore the Ribbon. 

 Or, to minimise or restore the Ribbon, press CTRL+F1. 

 
Restore the Ribbon 

 Click Customize Quick Access Toolbar Button image. 

 In the list, click Minimize the Ribbon. 

 Or, to minimise or restore the Ribbon, press CTRL+F1.  
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1.8 REVIEW EXERCISE 
 

1. URL stands for: 
a. Universal Real Location 
b. Uniform Resource Locator 
c. Universal Repeating Layout  
d. Unified Resource Layout 
 

2. Which of the following is not a web browser? 
a. Google Chrome 
b. Internet Explorer 
c. Microsoft Bing 
d. Mozilla Firefox 

 
3. What is a hyperlink? 

a. A page containing information found on the Web 
b. An application for browsing the Web 
c. An image or text on a Web page that connects to another location 
d. An address of a specific location on the Web.  

 
4. List three types of activities that you can carry out on the Web. 

__________________________________________________ 
__________________________________________________ 
 

5. Open your Web browser. Turn on the browser’s Menu bar and Favorites bar. 
 
 

 

 

  



 

 

LESSON 2 -  

NAVIGATION  

In this section, you will learn about: 

 

 The address bar 

 Navigation buttons  

 New tabs  

 Tabbed browsing  

 Favorites  

 Organising favorites  

 Deleting favorites 

 Browsing history  
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2.1 THE ADDRESS BAR 

 Concepts 

In order to browse to a specific website you need to enter its URL in the address 

bar. Then hit the Return key on your keyboard. 

 

 

2.2 NAVIGATION BUTTONS 

 Concepts 

The Internet Explorer toolbar displays navigation buttons to access already visited 

web pages. With the back and forward navigation buttons, you can browse 

through these pages. 

 

Internet Explorer uses four buttons for navigation: the Back, Forward, Refresh, 

and Home buttons. 

 

The Back and Forward buttons allow you to move through pages you've recently 

viewed. Click and hold either button to view your recent history. 

 

  Steps 
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Steps Practice Data 

1. Refresh a Web Page. 

The web page will reload. 

Click on the Refresh icon 

(near the address bar). 

 

2. Stop a Web Page. 

The web page will stop loading. 

Click on the Stop icon to stop 

the Web Page from loading. 

 

3. Using the Standard Toolbar. 

 

4. The Home button will navigate to 

www.msn.com by default. If you want to, 

choose your own homepage. 

You will be redirected back to the selected 

homepage.  

Click the Home button, which 

will take you directly to your 

homepage. 

 

 

 

2.3 NEW TABS 

 Concepts 

Internet Explorer identifies the websites you visit most and puts them one click 

away. Once you're in the browser, the New Tab page allows you to browse quickly 

to frequently visited websites. 

 

 

Frequently Visited Websites on Internet Explorer 
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  Steps 

Steps Practice Data 

1. To open a new tab. 

A new tab opens. 

Click the New Tab button or press 

CTRL+T.  

 

 

If you prefer that your home page appear when you open a new tab, follow these 

steps: 

 

Steps Practice Data 

1. Open Internet Explorer. 

The Internet Explorer web browser 

opens. 

Click & open Microsoft Explorer. 

 

2. Click the Tools button. 

The Tools dropdown list displays. Click the Tools button,  and 

then click Internet Options. 

3. Change Tabs Settings. 

The Tabbed Browsing Settings 

dialog box appears. 

Click the General tab, and then, 

under Tabs, click Settings. 
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4. In the Tabbed Browsing Settings 

dialog box, select Your first home 

page from the When a new tab is 

opened: dropdown list. 

The Tabbed Browsing Settings 

dialog box closes. 

 

 

Click Your first home page, click 

OK, and then click OK again. 

 

 

2.4 TABBED BROWSING 

 Concepts 

To open a new tab, click on the new tab icon, and to close the tab click on the x 

button shown on the tab which you want to close. To switch from one tab to 

another click on the name shown on the tab.  

 

2.5 BOOKMARKS 

 Concepts 

If you want to revisit a web site you can bookmark it. This means that you save it, 

so next time all you have to do is choose it from a menu. 
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  Steps 

Steps Practice Data 

1.  Go to the website that you wish to set 

as a bookmark and click on the Star at 

the right hand side of your Internet 

Explorer browser. 

You will be able to View favorites, 

feeds, and history. 

 

Click  

2. Select Add to favorites button. 

The Add a Favorite dialog box opens. 

Click Add to favorites. 

3. Give a name to your bookmark. 

Choose the folder which you want to 

add the bookmark to. 

The bookmark will be added to the 

folder.  

Click Add.  

 

 

If you have the Favorites bar displayed in your browser you can also hit the  

button in the top left corner, which will add the webpage to the Favorites bar. 

 

2.6 DELETING A BOOKMARK 

 Concepts 

If you have bookmarked a page in the past that you used frequently but no longer 

need it now, you can delete it from your bookmarks list.  

  Steps 

Steps Practice Data 

1. Click on the Star at the right hand side of 

your Internet Explorer browser. 

You will be able to View favorites, feeds, 

and history.  

Click  

2. Click on Favorites. 

The Favorites tab will appear. 

Click Favorites. 
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Steps Practice Data 

3. Choose the bookmark you wish to delete. 

The bookmark will be deleted.  

Right click on the bookmark that 

you wish to delete, and click 

delete.  

 

 

 

2.7 SHOW BOOKMARKS / FAVOURITES 

 Concepts 

You can view your bookmarks and favorites to help you manage your bookmarked 

websites.  

  Steps 
 

Steps Practice Data 

1. Click Favorites. 

You will be able to View favorites, feeds, and 

history. Click  
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Steps Practice Data 

2. Select the webpage that you wish to display. 

The web page will appear.  

Click on the webpage. 

  

 

 

2.8 CREATE A BOOKMARK FOLDER 

 Concepts 

You can create folder so that you can group related bookmarks, or bookmarks 

with a common theme.  

  Steps 

Steps Practice Data 

1. Display your Favorites. 

You will be able to View favorites, feeds, and 

history. Click   
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Steps Practice Data 

2.  Bring up the option to Create new folder. 

This will allow you to add a new folder. 

Right click anywhere in the 

Favourites pane.

 

3. The option to add a new folder will appear. 

You can make a new folder for your 

bookmarks.  

Click Create new folder. 
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Steps Practice Data 

4.  Type in a name for your folder and press 

Enter. 

The new folder will be added.  

Hit Enter. 

 

2.9 DELETING A BOOKMARK FOLDER 

  Steps 

 

Steps Practice Data 

1. Display your Favorites. 

You will be able to View favorites, feeds, 

and history. Click  

2. Select the bookmark folder that you wish 

to delete. 

The option to remove the folder will 

appear. 

Right-click on the bookmark 

folder. 

 

3. Delete the folder.  

The folder will be deleted from the 

Favorites pane. 

Click Delete. 
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2.10 BROWSING HISTORY 

 Concepts 

You can review the list of website that you have visited, and you can also delete 

this information. 

  Steps 

 

Steps Practice Data 

1. Open Favorites. 

You will be able to View favorites, feeds, and 

history. Click   

2. View history arranged in dated categories. 

The default ordering of your history is View 

By Date. All sites visited (up to the default 

history time limit) are grouped into time 

periods.  

Browsing History will be displayed.  

 

Click History. 

 

3. Click the Tools button to delete history. 

 
Click  

4. Select Safety. 

    A list of safety options will appear.  
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Steps Practice Data 

5. Click Delete browsing history. 

A new window will appear which allows you 

to specify what you want Internet Explorer to 

delete. 

 

6. Select what you want to delete from your 

browsing history.  

You will have a selection of items to delete 

such as Internet history, temporary Internet 

files and form data.  

 

 

 

You can also view your most recently visited websites by clicking the down arrow 

in the address bar, as shown below.  
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2.11 REVIEW EXERCISE 

 

1. Name three navigation buttons in Internet Explorer.  
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 

2. Which of the following does not appear under the  button: 
a. Favorites  
b. Downloads 
c. History 
d. Feeds 

 

3. What is the shortcut to open a new tab in Internet Explorer: 
a. Ctrl+T 
b. Ctrl+P 
c. Ctrl+N 
d. Alt+T 

 

4. List four items that you can delete from the browsing history window: 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 

5. You can only view recently visited websites by clicking  and then history. 
a. True  
b. False 
 



 

 

LESSON 3 -  

SEARCHING THE WEB  

In this section, you will learn about: 

 

 Search engines  

 Advanced search  

 Search tips  

 Website searches  

 Finding text on a page  

 Critical evaluation  
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3.1 SEARCH ENGINES 

 Concepts 

A search engine is a tool used to search for information on the World Wide Web. 

The search results are usually presented in a list and are often called hits. 

 

Examples of Search engines are:  

www.google.com 

www.bing.com 

 

 

3.2 ADVANCED SEARCH 

 Concepts 

Many people think that when you use a search engine such as Google, it will 

magically search the entire Web and find information that you require. The first 

thing to understand is that a search engine like Google will only search through a 

list of maintained sites that have been registered with that particular search 

engine. 

This in part explains the differing results you sometimes get when you search 

using different search engines. Also, each search engine has different criteria for 

ranking search results. A number of search results per page are presented with a 

brief description about each site that it has found matching your requirements. 

 

Here are some tips that one should keep in mind when using a search engine: 

 Use two or more words, or a short phrase when searching for information. 

 Try to use unique words that directly relate to what you are searching for. 

http://www.google.com/
http://www.msn.com/
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 For instance if you are searching for information about ICDL training then 

search for ICDL training, not just training, which would include all sorts of 

training. 

 Often, you would be better enclosing your search phrase with quotation 

marks (“”).This will then mean that the search engine will look for the exact 

phrase that you have entered. If you search for “ICDL training” you will only 

get results that use that exact term, and not results containing just “ICDL” 

or just “training”.  

  Steps 

Steps Practice Data 

1. Input the URL of a search engine in your 

web browser and hit the Enter key. 

The search engine will appear. 

Type www.google.com and 

press Enter. 

 

2. To use advanced search options you need 

to perform a general search on what you are 

looking for.  

Performing the search will bring up a 

selection of results. 

Use Google Search 

 

3. Having begun your search, you can use the 

filters Google has provided.  

Using each filter will vary the results shown 

on screen.  

Filter your search results. 

 

4. Google offers an advanced search tool that 

can filter results to a further level.  

Using Advanced search will allow you to find 

results based on further specifications. 

Click Options, and click 

Advanced search. 

 

 

Google’s Advanced search lets you search using criteria including: 

 Exact phrase 

http://www.google.com/
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 Date 

 Language 

 By excluding words 

 By file format, media type etc. 

 

Google Advanced Search 
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3.3 SEARCH A WEB-BASED ENCYCLOPAEDIA, 

DICTIONARY  

 Concepts 

Encyclopaedia 

There are several online encyclopaedias and dictionaries available on the web. In 

this section we will look at some examples. 

 

Enter the URL below in your web browser: 

http://www.britannica.com/topic/Encarta 

To use Encarta‘s online encyclopaedia, type your keyword or phrase in the search 

box, and click Return. 

 

 

 

Dictionary 

Enter the URL below in your web browser: 

http://dictionary.reference.com/ 

 

To find a definition of a work in the online dictionary, use the search box to type 

the word, and click Return. 

 

 

 

Other examples of online encyclopaedias / dictionaries include: 

 

 www.encyclopedia.com 

 www.wikipedia.org 

 www.yourdictionary.com 

 www.alphadictionary.com 

 

http://dictionary.reference.com/
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TIP: To force a search engine to give you definitions from web based dictionaries, 

type “define:” before your actual keyword when using the search engine’s search 

box. 

 

3.4 CRITICAL EVALUATION 

 Concepts 

There is an enormous amount of content available online. It is important that you 

critically judge the content you read, view, or hear. Not everything online is true or 

accurate! One way to help you in the process of critical evaluation is to recognise 

different types of websites and their purpose.  

 

The most basic site is informational. An example of such a site is one that tells a 

potential customer or visitor what a business is, where it’s located, its hours, how 

to contact the business owner and maybe a bit more.  

 

Another type of informational site is an online encyclopaedia, such as Wikipedia. 

This is used as a reference on a huge range of topics.  The content is written and 

edited by anyone who wants to participate, but this has implications for accuracy 

and consistency. 

 

Many websites provide entertainment. For example, while YouTube certainly has 

educational and informational purposes, it is most often turned to for its 

entertainment value. Opinion sites are used by bloggers and writers to discuss 

their thoughts on particular topics, often dealing with relevant stories of the time. 

By their nature, opinion sites such as blogs tend to express subjective views.  

 

Finally, there are commercial sites, focusing on selling. These sites exist primarily 

to promote or sell a product or service directly, or to facilitate selling. Amazon.com 

and eBay are examples of sites that facilitate selling. Some sites that appear to be 

informational may in fact be promoting or selling a product or service.  

 

Judging Website Credibility 

While the Internet is an invaluable repository of online resources, news and 

materials, it is important to remain vigilant when quoting or referencing websites, 

as many can post false or inaccurate information. Here are a few factors that can 

be considered when judging the credibility of a website and its material.  
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 Author 

It is important to recognise the author of what you are viewing when online. 

Are they a credible professional in their field? Are they writing from a 

position of knowledge on the subject? If the author has not given their 

name or written under the title “Anonymous” then it may not be very 

reliable. Searching for other material they have written or put their name to 

can be a good way of checking whether or not they are a dependable 

source.  

 

 Referencing 

If an author or website is quoting individuals, statistics or other factual 

pieces, there should be clear references to the work they are getting their 

information from. If there are no clearly stated references then it is possible 

that they may not be providing accurate material, and it would be right to 

question its credibility. 

 

 Up-To-Date Content  

A website’s currency is important when taking into account information that 

may be statistical or time-sensitive. Material on a site should remain current 

and be maintained, so keeping an eye out for when it was last updated, 

when articles or videos were posted and other date-recorded information 

can help ensure the material you want is of use.   

 

In addition, when reviewing a website, it is important to consider whether or not 

the website’s content is appropriate for, and meets the needs of, its target 

audience. If a site is designed for children, for example, the website’s content, 

layout and interactivity must be age appropriate. 
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3.5 REVIEW EXERCISE 

 

1. Open Google search and find four other examples of search engines on the Internet. 

__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 
2. Which of the following is not an online dictionary / encyclopaedia: 

a. www.wikipedia.org 
b. www.thesaurus.com 
c. www.google.com 
d. www.britannica.com 

 
3. Use Google search to identify four examples of websites primarily focussed on 

selling items.  
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 
4. Which of the following is not used to judge website credibility: 

a. Author 
b. Place in search engine results 
c. Referencing 
d. Up-to-Date content  

 

 

 



 

 

LESSON 4 -  

WEB PAGE INTERACTION 

In this section, you will learn how to: 

 

 Download files  

 Save pictures  

 Print a web page / selection of web pages  

 Complete a form 

 Translate a web page 
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4.1 DOWNLOADING FILES 

  Steps 

There are two ways to download a file from a web page. 

 

Option 1: 

Steps Practice Data 

1. Left click on the download hyperlink. 

A window will open, as illustrated. 

 

2. Save the files to a desired location. 

The files will be saved to the selected 

location. 

Click Save, and enter the 

desired location.  

 

Option 2: 

Steps Practice Data 

1. Select on the download hyperlink. Right-click the hyperlink. 

2. Bring up a window to save the file to a 

location. 

A Windows window will appear. 

Click Save Target As… 

 

3. Choose a destination where you wish to 

save the file. 

The files will be saved to the selected 

location. 

Click Save, and enter the 

desired location. 
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4.2 COPY TEXT, IMAGE, URL TO ANOTHER LOCATION 

LIKE: DOCUMENT, E-MAIL  

  Steps 

Copy text from a web page to a document or e-mail. 

 

Steps Practice Data 

1. Select the text you wish to copy. 

The text will appear highlighted.  

Highlight the text. 

2. Copy the text. 

The text will be copied to the dashboard.  

Right-click, and click Copy. 

 

3. Paste the text into the document.  

The copied text will appear in the document.  

 

Open the document where 

you wish to paste your text. 

Right-click, and click Paste. 

 

 

Copy an image from a web page to a document. 

 

Steps Practice Data 

1. Select the image you wish to copy. Right-click on the image. 
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2. Copy the image. 

The image will copy to the dashboard. 

Click Copy. 

 

3. Paste the image into a document. 

The image will appear in the document.  

Open the document where 

you wish to paste your text. 

Right-click, and click Paste. 

 

Copy a URL from a website: 

Steps Practice Data 

1. Select the URL in the address bar. 

The URL will be selected.  

Right click on the website 

URL in the address bar. 
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Steps Practice Data 

2. Copy the web address. 

The link will copy to the dashboard.  

Click Copy. 

 

3. Paste the URL into a document.  

The link will appear in the document.  

Open the document where 

you wish to paste your text. 

Right-click, and click Paste. 

 
Tip: To quickly copy an item press Ctrl+C on your keyboard. To quickly paste an 

item press Ctrl+V. 

 

4.3 PREVIEW, PRINT A WEB PAGE, SELECTION FROM 

A WEB PAGE USING AVAILABLE PRINTING OPTIONS 

  Steps 

Preview a Web Page: 

 

Steps Practice Data 

1. Select the arrow next to the printer icon in 

your web browser. 

The print options will appear. 

Click on the Print arrow. 
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Steps Practice Data 

2. Choose Print Preview. 

The preview will appear onscreen.  

Click Print preview…

 

 

Print a Web Page or a selection from a web page: 

Steps Practice Data 

1.  Select the arrow next to the printer icon in 

your web browser. 

The print options will appear.  

 

Click on the Print arrow. 

2.  Select Print. 

 

Click Print. 

3.  The dialog box opens. 

The dialog box will allow you to adjust 

various settings.  

Print Dialog box. 

 

 

You can use this dialog box to change several settings before giving the actual 

print command. 

In the Page Range section you can choose to: 

 Print all the pages in a specific webpage. 

 Print a Selection from the webpage (you need to highlight the text first.) 

 Print a range of pages. 

 You can also set the number of copies for a specific print page. 

When you have made all the necessary changes click the Print button. 
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Tip: You can open the print feature by pressing Ctrl+P.  

 

4.4 COMPLETE, SUBMIT, RESET A WEB BASED FORM  

 Concepts 

Sometimes when using the Internet for subscribing to a website, creating an e-

mail account, completing an online survey and so on, you will be asked to fill in 

web-based forms. These forms include elements such as text fields, drop-down 

fields and check boxes in which you record information. 

 

Below is an example of a web-based form used by Outlook.com when creating a 

new account: 

 

Create an account for Outlook 

 

Normally you can use the Tab key to move from one field to the next field within 

the form. 

 

Generally, web-based form will have Submit and Reset buttons. 

 Use the Submit button when you are ready to submit your completed form. 

 Use the Reset button if you wish to empty your form to start afresh. 
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4.5 USE A WEB TOOL TO TRANSLATE A WEB PAGE, 

TEXT 

 Concepts 

Various online tools can be used to translate for free a web page or text to another 

language. Google Translate is one such service.  

  Steps 

To use Google Translate: 

 Enter the URL https://translate.google.com/ in the address bar. 

 Write the Text / URL in the translation box. 

 Choose language From and To, or allow Google to Detect language for 

you. 

 Click on Translate. 
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4.6 REVIEW EXERCISE 

 

1. The two methods of downloading files from the Internet both involve opening a: 

a. New window 

b. New tab 

c. Web link 

d. Hyperlink  

 

2. Go to icdl.org and print the homepage.  

 

3. What key can you normally use when filling in a web-based form to move from one 

field to the next: 

a. Return 

b. Backspace 

c. Shift 

d. Tab 

 

4. To use Google Translate you must know the language you are translating from and 

input it into Google Translate or else it will not work. 

a. True 

b. False 

 

5. Go to icdl.org and copy the first paragraph under “ECDL Foundation” to the 

dashboard. Open Google Translate and paste the text into the text box. Choose a 

language of choice to translate to.  

 

 



 

 

LESSON 5 -  

SETTINGS & SECURITY  

In this section, you will learn about: 

 

 Home page settings  

 Blocking pop-ups  

 Allowing / blocking cookies  

 Securing websites  

 Controlling Internet use  

 Staying safe online 

 Data protection  

 Copyright  
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5.1 HOME PAGE SETTINGS  

 Concepts 

The home page is the website that appears every time you open your web 

browser. You can set the home page to any website you wish.  

 Steps 

To change the home page you have to: 

 

Steps Practice Data 

1. Select Tools. 

This will open the various options under 

Tools. 

Click Tools. 

 

2. Select Internet Options. 

A variety of Internet options will appear.   

Click Internet Options. 

3. Select the General tab of the Internet 

Options dialog box. 

You will be able to set the home page in this 

tab.  

Click the General tab. 

 

 

 If you wish to use the currently displayed page as your home page, 

click on Use current. 

 If you wish to use the website you had before as the default click on Use 

default. 

 If you wish to have a blank page for your home page click on Use blank. 

 If you wish to use another home page enter the full URL into the home 

page box. 

 Click OK to close the Internet Options dialog box. 
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5.2 BLOCKING POP-UPS 

 Concepts 

Pop-ups are windows that open automatically when you visit some websites. 

Such pop-ups may relate to gaming or explicit content, and are generally 

unnecessary. Some pop-ups may be dangerous to your computer; others are not 

harmful at all. 

 

What is a pop-up blocker? 

Pop-up Blocker is a feature that lets you limit or block most pop-ups. You set the 

level of blocking you prefer, from blocking all pop-up windows to allowing certain 

pop-ups. When Pop-up Blocker is turned on and it blocks a Pop-up, the browser 

displays a message saying "Pop-up blocked. To see this pop-up or additional 

options click here." 

 

  Steps 

 

To block / allow pop-ups: 

Steps Practice Data 

1. Select Turn on Pop-up Blocker from the 

Tools menu. 

You will be able to choose whether to allow 

or block pop-ups depending on your current 

settings.   

Click Tools, point to Pop-up 

Blocker, and click Turn on 

Pop-up Blocker. 
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Steps Practice Data 

2. Select Turn off Pop-up Blocker from the 

Tools menu.  

You will be able to choose whether to allow 

or block pop-ups depending on your current 

settings.   

Click Tools, point to Pop-up 

Blocker, and click Turn off 

Pop-up Blocker. 

 

 

5.3 COOKIES 

 Concepts 

Cookies are small pieces of data that are sent by websites to your browser when 

you are browsing. They have different functions, including recording of browsing 

activity. Their use raises privacy concerns, but they can also make navigating the 

Web easier. 

  Steps 

To allow / block cookies: 

 

Steps Practice Data 

1. Select Tools. 

The tools menu will appear. 

Click Tools 

2. Select Internet Options. 

A variety of Internet options will appear.  

Click Internet Options. 
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Steps Practice Data 

3. Select the Privacy tab. 

A selection of privacy options for Internet 

Explorer can be set.  

Click the Privacy tab  

 

4. Select Advanced. 

Advanced options will appear.  

Click Advanced. 

 

5. Click Override automatic cookie handling. 

You can then specify how you want Internet 

Explorer to handle cookies from first-party 

Web sites (the website you are currently 

viewing) and third-party Web sites (a Web 

site other than the one you are currently 

viewing). 

Click Override automatic 

cookie handling. 
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Steps Practice Data 

6. To specify that you want Internet Explorer to 

always allow cookies to be saved on your 

computer, click Accept. 

Click Accept. 

 

7. To specify that you want Internet Explorer to 

never allow cookies to be saved on your 

computer, click Block. 

Click Block. 

 

8. To specify that you want Internet Explorer to 

ask whether or not you want to allow a 

cookie to be saved on your computer, click 

Prompt. 

Click Prompt. 

 

9.   If you want Internet Explorer to always allow 

session cookies (cookies that will be deleted 

from your computer when you close Internet 

Explorer) to be saved on your computer, 

click Always allow session cookies. 

Click Always allow session 

cookies. 
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5.4 SECURITY AND SAFETY 

 Concepts 

There are a range of measures that you can take to protect yourself when you are 

online. 

 

Purchase from Secure Reputable Websites 

When shopping online, take steps to check the security and reputation of a web 

site. For example, is the web site linked to an established business that has a 

physical presence? Are there independent reviews of the web site? If you cannot 

answer yes to these questions, maybe you should reconsider using the web site. 

You should also check that the Internet connection is secure before you make a 

payment. 

 

Avoid unnecessary disclosure of personal and financial information 

Do not give any personal or financial information over the Internet if the website is 

not secure. Even if the connection is secure, you should only provide personal 

and financial information if it is necessary to make a purchase. In addition, you 

should be very cautious about providing personal and financial information in 

other contexts, for example when communication via e-mail or instant messaging. 

If you are chatting on a discussion board or via instant messaging with someone 

you do not know personally, use a nickname instead of your real name. Be wary 

of strangers who may be interested in getting you to reveal personal information 

that they might seek to misuse.  

 

Log off from websites 

It’s important that you remember to log out from any website that you have 

logged in to when you have finished browsing, especially if you are on a 

computer or device to which other people have access. If you do not log out, 

other people may gain access to your personal or financial information, or may 

impersonate you.  

 

5.5 ENCRYPTION 

 Concepts 

Encryption is the conversion of data into a form that cannot be easily read and 

understood by people.   
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Encryption is used to protect data as it’s passed over a network. It is often used to 

prevent illegal access to or reproduction of information. 

Decryption is the process of changing encrypted data back into its original form, 

so that it can be read. Decryption uses a key, or algorithm, to “unlock” the 

encrypted data. A common use of encryption is when data is sent through a 

secure web connection.  

 

5.6 SECURE WEBSITES 

 Concepts 

When you use a website that handles private or financial information, you should 

check that it is secure. 

 

To see if a website is secure, make sure that a lock icon displays in the browser 

window and that the website's address begins with "https" (instead of "http"). 

Hypertext Transfer Protocol Secure (“https”) is a combination of the Hypertext 

Transfer Protocol and a security / encryption protocol. These connections are 

often used for payment transactions on the Web and for sensitive transactions in 

corporate IT systems. 

 

Even if you do not plan to view or provide private information, it's best to use a 

secure login whenever possible, to ensure that your login information is encrypted. 

 

Try typing the following URL in your web browser: 

 

www.facebook.com.  

 

Note that the URL automatically changes to add https at the front of the web 

address, and you will also see the padlock. This means that the connection to this 

website is secure. 

 

The same usually applies if you connect to a financial institution: for example, 

www.citibank.com 

 

http://www.citibank.com/
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Digital Certificate 

E-commerce has flourished because of the ability to perform secure transactions 

online using the proper tools. In addition to encryption, digital certificates play an 

important part in supporting secure transactions. 

 

Digital certificates are trusted ID cards in electronic form that bind a website's 

public encryption key, which it uses to encrypt data, to their identity for purposes 

of public trust. 

 

Digital certificates are issued by an independent, recognised and mutually trusted 

third party that guarantees that the website operating is who it claims to be. This 

third party is known as a Certification Authority (CA). Without digital certificates, 

the public has little assurance as to the legitimacy of any particular website. 
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When a Web browser like Internet Explorer makes a secure connection, the digital 

certificate is automatically turned over for review. The browser checks it for 

anomalies or problems, and displays an alert if any are found. When digital 

certificates are in order, the browser completes secure connections without 

interruption. 

 

Digital certificates play an integral role in keeping online commerce safety. If your 

browser alerts you to a problem with a digital certificate, you should think twice 

about proceeding. Instead, try to contact the business through other means, such 

as by telephone to help you decide whether or not you should proceed with a 

transaction.  

 

Not all Certificate Authorities are equal. Some CAs are newer and less well 

known. Two examples of highly trusted CAs are VeriSign and Thawte. If your 

browser does not recognise a Certificate Authority, it will alert you. 

 

5.7 CONTROLLING INTERNET USE 

 Concepts 

It is highly recommended that parents are aware of their children’s activities 

online. Parents should take an active interest in their children’s online activities, 

and should – especially for younger children – be available to guide them through 

online environments and to explain and monitor what they are viewing and who 

they are engaging with. Parental control includes features such as: 

 

 Supervision   

 Web browsing restrictions 

 Download restrictions. 

 

5.8 COPYRIGHT AND INTELLECTUAL PROPERTY 

 Concepts 

Copyright is a legal right that gives the creator of an original work, such as text or 

an image, exclusive rights for its use and distribution. Intellectual property refers to 

the work that has been created and can be protected by laws such as copyright.  
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For example, most software programmes that you buy are copyrighted and you 

are generally not permitted to copy and share them.  

 

Copyright and intellectual property does not just apply to software. You should 

assume that copyright applies to all information that you find on the Web. For 

example, if you are researching a topic for a study paper or a blog and you find 

some interesting material online, you cannot just copy this and present it as your 

own. You may, however, be able to cite or quote from other sources as long as 

you give a reference to that source.   

 

Some websites have copyright information in their footers or on the home page. 

These may set out the terms under which you can copy information from the 

website. 

 

If you are in any doubt about whether or not you can reuse specific content, you 

should always get the permission of the copyright owner. If you are found guilty of 

copyright infringement or plagiarism, you could face legal punishment.  

 

5.9 DATA PROTECTION 

 Concepts  

Data protection refers to the legal procedures that must be adhered to in relation 

to access, collection and use of data, including data stored on a computer. In 

general it holds that personal data shall be obtained only for a specified and lawful 

purposes, and that it should not be processed in any manner incompatible with 

those purposes. If personal information has been stored, it should be destroyed 

once it is no longer needed. Data subjects should also be notified if data about 

them has been distributed in an unauthorised way. 

 

You should familiarise yourself with the data protection laws in place in your 

country, as they can differ between regions.  

  



ECDL Online Essentials Lesson 5 – Setting & Security 

© 2016   Page 51 

5.10 REVIEW EXERCISE 

 

1. What tab in Internet Explorer do you use to set the homepage: 

a. Edit  

b. View 

c. Favorites 

d. Tools 

 

2. Some pop-ups are harmful to your computer while others are not.  

a. True 

b. False 

 

3. A small piece of data that is sent by a website to your browser when you are 

browsing is called a: 

a. Cookie  

b. Pop-up 

c. Web cache 

d. Add-on 

 

4. ____________ is a trusted ID card in electronic form that binds a website’s public 

encryption key to their identity for purpose of public trust.  

a. A digital certificate 

b. An encryption key 

c. An IP address 

d. A certification authority 

 

5. Search for your country’s data protection policy to familiarise yourself with what 

policies are in place.  

 



 

 

LESSON 6 -  

COMMUNICATION  

In this section, you will learn how to: 

 

 Communicate online  

 Participate in online communities  

 Share content  

 Preserve privacy and security 
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6.1 COMMUNICATING ONLINE 

 Concepts 

A variety of tools are used to communicate online, including Instant Messaging, 

SMS/SMS, and VoIP. 

 

Instant Messaging 

IM – short for instant messaging – is a type of real-time 

communication service. It is somewhat like e-mail, but much 

more like a chat room. Both parties are online at the same 

time, and they "talk" to each other by typing text and sending 

small pictures instantaneously.  

 

SMS and MMS 

The acronym SMS stands for short message service. SMS is also often referred 

to as texting, sending text messages or text messaging. The service allows for 

short text messages to be sent from mobile phone to another mobile phone or 

from the Web to another mobile phone. 

 

Multimedia Messaging Service (MMS) is a standard way to send messages that 

include multimedia content to and from mobile phones. It extends the core SMS 

capability that allowed exchange of text messages only up to 160 characters in 

length. 

The most popular use is to send photographs from camera-equipped phones, 

although it is also popular as a method of delivering news and entertainment 

content including videos, pictures, text pages and ringtones. 

 

 

Voice over Internet Protocol (VoIP) 

VoIP is a technology that allows you to talk with other 
people using the Internet. You can talk at no extra cost to 
other people using VoIP on their computers or Internet connected devices. You 
can even make calls to “real” telephones at a much cheaper rate than normal. 
Common VoIP services include Skype.   
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6.2 ONLINE COMMUNITIES 

 Concepts 

An online community (also referred to as virtual community) is a network of 

individuals that primarily interact via online communication methods, as opposed 

to face-to-face interaction, for social, professional, educational and other 

purposes. This is done through social networks, forums, e-mail, newsletters or 

instant messages. As the mechanism is a computer network, it is called an online 

community. Virtual and online communities have also become a supplemental 

form of communication between people who know each other primarily in real life.  

 

Social Networking Websites 

There are a lot of social networking sites through which virtual communities are 

usually created. Social networking websites offer you the possibility to find old and 

new friends, communicate with your friends 

through messages and instant messages, 

upload your photos and comment on friend‘s 

photos, and more. 

 

Two examples of Social Networking websites 

are Facebook (www.facebook.com) and 

Twitter (www.twitter.com).  

 

Internet Forums 

An Internet forum is an online discussion site where members can post 

discussions as well as read and respond to posts created by other forum 

members. An Internet forum can be focused on a specific subject, or host a range 

of subsections that can contain hundreds of threads and topics. 

 

An Internet forum is also called a message board, discussion group, bulletin board 

or web forum. What makes a forum different to a chatroom or personal blog is that 

it is usually focussed on a particular topic and contains in-depth replies, allowed to 

be posted by any member. A chatroom generally has a more general tone, while 

blogs (web logs) are typically written by one author, and only responses to their 

posts are typically allowed on the site.  
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Web Conferencing 

A web conference is an online meeting in which users connect to the Internet and 

use computers to conduct a meeting as though they were all in the room together. 

Some Web conferencing systems 

include features such as texting, 

VoIP (voice over IP) and full-motion 

video.  

 

Web conferencing allows users to 

carry out activities such as 

business meetings, seminars, 

presentations through video. 

Screens can be shared so that 

presentations and visual items can be seen by all, and control over the conference 

can be shared. Some web conferencing services automatically enlarge the picture 

of those speaking during a web conference to show who is talking and when. This 

type of service does require high speed Internet between all users for it to be fully 

effective.  

 

Chat Room 

A chat room is a virtual space on the Internet that allows users to communicate 

with one another in real time, text communication. Chat rooms can be a website in 

its own right or a part of a larger site, such as social media (Facebook) or a part of 

a business’s customer support section on their website. 

 

Chat Room Etiquette 

Because chat rooms are places where so many different types of people come 

together to communicate with one another, 

certain rules need to be in place to keep 

the peace. Many chat rooms are constantly 

moderated for any offensive activity, but 

smaller chat rooms may lack such 

moderation, and it is therefore up to the 

users to be sure that no offensive activities 

take place.  

 

Online Computer Games 

Online computer games are also another type of online 

communities. Such games enable thousands of players 

from across the globe to come together online through 

computer gaming.  
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6.3 PUBLISH AND SHARE ONLINE CONTENT 

 Concepts 

There are a variety of ways for content to be published and distributed online, 

through both audio and visual media. They include Blogs, Podcasts, Images, 

and Audio and Visual clips. 

 

Blog 

A blog is a shared online journal that allows authors, called bloggers, to write 

about subjects they specialise or have a keen interest in. These blogging sites can 

have one author or many, and can vary in how content and blogs are presented. 

Popular blogging platforms include WordPress.com, Blogger.com, and 

Tumblr.com, with the latter combining elements of social media to its site.  

 

Microblog 

Microblogging is a shared online journal with shorter updates compared to a 

conventional blog post. Microblogs tend to be found on social media platforms, 

most prominently Twitter, as well as status updates posted on Facebook.  

 

Podcasts  

A podcast is a digital audio file released regularly and downloadable, often 

through an RSS feed. Podcasts are generally released as part of a series, and 

can include documentaries, debate shows or radio shows released by a radio 

station after their broadcast ends.  

 
Images 

Thanks to improved camera technology on smart phones as well as social media 

sites dedicated to photo sharing, such as Instagram, original digital photos and 

graphics can be shared and distributed almost instantly.  

 

Audio and Video Clips 

Audio and Video clips are most commonly shared on websites such as YouTube 

and Flickr, primarily as a source of entertainment. They can also be used to 

produce and share educational, informative and opinion-based videos. 
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6.4 GOOD ONLINE COMMUNICATION PRACTICE 

 Concepts 

It is important to maintain good practice when communicating online for the safety 

and enjoyment of you and fellow users of an online communication service. There 

are guidelines that can be followed and applied to most forms of electronic 

communication, including e-mails.  

 

 Be accurate and brief: Try not to send messages that are overly long and 

complex, and choose your words carefully to accurately express your view.  

 

 Use clear subject headings: Make the topic of the message clear for the 

recipient. This will also help ensure your mail doesn’t end up in a spam or 

junk folder.  

 

 Do not inappropriately disclose personal details: Be careful to who and 

how you disclose personal details as they may be misused.  

 

 Do not circulate inappropriate content: It is important to remember who 

you are mailing and to consider what tone and content is appropriate for 

that person. Also remember that messages can easily be distributed more 

broadly by the recipient.  

 

 Spell check content: In all forms of interaction, but particularly when 

sending formal communication, it is important that your grammar and 

spelling is correct.  

 

6.5 PRIVACY AND SECURITY 

 Concepts 

Because people are spending an increasing amount of time online, it is important 

that everyone takes reasonable measures to protect their privacy and security.  

 

Privacy Settings 

Applying the appropriate privacy settings when using online communication tools 

can help you stay safe and keep sensitive information secure. Making your profile 
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private on some social media sites might not be the option everyone chooses, but 

it can help you moderate who can see your posts, news and any information you 

choose to share.  

 

Restrict Available Personal Information 

This will help you the most when avoiding identity theft and fraud. By restricting 

where and when you post information such as your address, date of birth, 

telephone number, you can improve your chances of staying safe online. A lot of 

websites that ask you to sign up require you to give personal information, but 

always be wary of how secure the links are and how legitimate the site is.  

 

Private Messaging 

If there is a private messaging service available to you, you should always use it 

when communicating information that you do not want others to see. If you make 

personal communications public there is a higher chance someone unwanted will 

view it and use this to their benefit, if they are capable of doing so.  

 

Disable Location Information 

Disabling the service that tracks (and sometimes posts) your exact location when 

you post on a social media network is vital in ensuring your own security. People 

can monitor what time you are out of your house, where you go at certain points of 

the day. This could leave you open to crimes such as burglary.   

 

Block / Report Unknown Users: 

If you are receiving online abuse or repeated messages from an unknown sender, 

it is best to block and report them to the website.  
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6.6 REVIEW EXERCISE 
 

1. Which of the following is not a method of communicating online: 
a. VoIP 
b. IM 
c. MMS 
d. IP 

 
2. An online discussion site where members can read, respond to posts written by other 

authors, and start their own discussions is called _________. 
a. An Internet forum 
b. A web conference 
c. A chat room 
d. A blog 

 
3. Name three methods of publishing and distributing content online. 

_________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 
4. Which of the following is not an advised privacy and security measure: 

a. Restrict personal information.  
b. Use private messaging.  
c. Enable location information.  
d. Block / report abusive users.   



 

 

LESSON 7 -  

GETTING STARTED (E-MAIL) 

In this section, you will learn about: 

 

 E-mail 

 E-mail usage 

 Structure of an e-mail address 

 E-mail attachments 

 Fraudulent and unsolicited e-mail 

 Phishing e-mails  
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7.1 WHAT IS E-MAIL 

 Concepts 

Electronic mail, generally known as e-mail, is a technology for exchanging 
information or messages on the Internet between a sender and one or many 
recipients.  
 
E-mail is generally acknowledged to have revolutionised business 
correspondence, and has become the main medium of electronic communication 
for many organisations. E-mail is easy to use and is more practical and efficient 
than postal mail. 
 

7.2 E-MAIL ADDRESS AND E-MAIL STRUCTURE 

 Concepts 

An E-mail address contains information about the e-mail box to which e-mail 

messages are delivered.   

For example, an e-mail address such as Jdoe@ecdl.org is comprised of a user 

name (JDoe), an @ symbol, a domain name (ecdl), and an extension (.org).  

 

E-mail Message 

E-mail messages comprise of two areas, the message header and the message 

body. The header is organised into fields, for example, From, To, CC, Subject, 

Date, and other data about the e-mail. The body contains the message and 

sometimes a signature towards the end. 

 

To: The e-mail address(es), and alternatively name(s) of the message's 

recipient(s).  

 

Cc: Carbon copy; for optional recipients who are not the primary intended 

recipient. 

 

Bcc: Blind carbon copy; addresses added to the list but not recorded in the 

message information, so that they cannot be read by other recipients. 

 

Subject: A brief synopsis of the topic of the message. Abbreviations are usually 

utilised as a part of the subject, including "RE:" for reply and "FW:" for forward. 
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7.3 E-MAIL ATTACHMENTS 

 Concepts 

An e-mail attachment is a computer file, such as a document, image, or audio clip, 

that is sent together with an e-mail message. One or more files can be attached to 

an e-mail message, and is a common method of sharing files between people. An 

e-mail client typically uses a paper clip symbol to indicate that a file is attached to 

an e-mail. 

 

Attachment File Size Restrictions 

It is important to note that different e-mail service providers may have different file 

size restrictions. Some Webmail providers will allow you to send a large e-mail 

message, but there is no guarantee that the recipient who uses a different e-mail 

service provider will receive the e-mail. Because of this the attachment size limit of 

the recipient does matter, as your e-mail will be rejected if your file is over the 

limit. 

 

E-mail  Service Account Attachment Size Limit 

(per e-mail)* 

Gmail  

25 MB 

 

Windows Live Hotmail 

Yahoo! Mail 

*Information correct as of November 2015. 

 

Restricted Attachment File Extensions 

Do not attach executable files to your e-mail messages, as they might be blocked 

by e-mail providers or the antivirus software installed on your recipients’ computer. 

 

For example, Gmail will not allow you to send or receive executable files (for 

example, files ending in .exe). In addition, Gmail does not allow these types of 

files even if they are sent in a zipped format.  
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7.4 FRAUDULENT AND UNSOLICITED E-MAIL 

 Concepts 

E-mail has proved to be a convenient and powerful communications tool. 

Unfortunately, it has also provided scammers and other malicious individuals with 

an easy means for attracting potential victims.  

 

A common scam is combining e-mail and bogus web sites to trick victims into 

revealing sensitive information. 

 
Recognising E-mail Scams 

Unsolicited commercial e-mail, or “spam,” can be the starting point for many e-

mail scams. Before the advent of e-mail, a scammer had to contact each potential 

victim individually by post, fax, telephone, or through direct personal contact. 

 

Many scams that spam support have existed for a long time. A common list 

includes: 

 “You have won the lottery!”  

 Easy money 

 “Free” goods 

 Diet and health pills. 

 

7.5 PHISHING E-MAILS 

 Concepts 

Phishing e-mails are crafted to look as if they have been sent from a legitimate 

organisation. These e-mails attempt to fool you into visiting a bogus web site to 

either download malware (viruses and other software intended to compromise 

your computer) or reveal sensitive personal information.  

 

For instance, an e-mail can be designed to look like it is from a major bank. It 

might have an alarming subject line, such as “Issue with Your Account.” These 

messages usually suggest that there has been an issue with your account details 

and that you must submit a form to resolve the problem. As some believe these e-

mails to be legitimate, they will click on the link and follow the instructions, 

resulting in sensitive information being passed on to phishers.  
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You can protect yourself from phishing e-mails by being wary of e-mails with 

dramatic subject lines, checking for grammar, and carefully examining the URL 

you are being directed to. You should also be aware that it is unusual for a 

legitimate institution, such as a bank, to ask for confidential information in this 

way. If in doubt, contact the institution directly yourself to validate the request.  
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7.6 REVIEW EXERCISE 
 

1. Which of the following is the main medium of electronic communication form many 

organisations: 

a. Postal mail 

b. E-mail  

c. Instant messaging 

d. Telephone 

 

2. Match the following description to the correct e-mail field: “Addresses added to the 

list but not recorded in the message information, so that they cannot be read by other 

recipients.” 

a. To  

b. Cc  

c. Bcc  

d. Subject 

 

3. True or false: A large e-mail will be delivered to the recipient so long as it does not 

exceed the sender’s file size restriction: 

a. True  

b. False  

 

4. Name 4 common types of scam e-mail subjects. 

__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 

5. Which of the following is not considered best practice when dealing with potential 

phishing e-mails: 

a. Checking spelling & grammar 

b. Remain wary of dramatic subject lines 

c. Follow the link and check what the website looks like 

d. Contact the institution directly to validate the request 

 



 

 

LESSON 8 -  

SENDING E-MAIL  

In this section, you will learn about: 

 

 Accessing an e-mail account 

 Using the Outlook interface 

 Using the Navigation bar 

 Customising the Navigation bar 

 Using Microsoft Outlook Help 

 Using the mail pane 

 Creating an e-mail 

 Performing a manual send/receive 

 Opening an e-mail message 

 Replying to a message 

 Forwarding a message 

 Changing the read status of a message 

 Flagging a message 

 Printing from the message list 

 Printing from the message window 
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8.1 ACCESS AN E-MAIL ACCOUNT 

 Concepts 

E-mail is commonly accessed through an online service, such as Gmail, or 

through an e-mail application that is installed on your PC or laptop. Microsoft 

Outlook 2016 is one of the most popular e-mail applications currently installed on 

computers.  

  Steps  

Open Outlook 2016. 

Steps Practice Data 

1. Select the Start button on the Taskbar. 

The Start menu appears. 
Click Start  

2. Click All Programs and scroll to Microsoft Office 

2016. 

The list of programs under the letter O will display. 

Scroll to Microsoft Office 

2016 

3. Select Outlook 2016. 

Outlook opens or the Choose Profile or Enter 

Password dialog box opens. 
Click  Microsoft 

Office Outlook 2016 

4. If prompted, follow the steps to select a profile, and 

enter your user name and password information. 

Outlook opens. 

Follow the instructions below 

to complete this step. 

 

If a Choose Profile dialog box opens, select a profile from the Profile Name list 

and select OK. If a dialog box opens prompting for your user name, password, 

and possibly your domain name, enter the appropriate information and select OK. 

 

8.2 USING THE OUTLOOK INTERFACE 

 Concepts 

Despite having a customisable interface, it is important to understand and work 

with the default layout on Outlook 2016. Once you can operate the default layout 

of Outlook it will be easier to set it up to your own specific needs.  

1. Quick Access Toolbar. The Quick Access Toolbar is located in the upper-

left corner of Outlook, containing commonly used commands for Outlook. 
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2. Ribbon. The Ribbon contains frequently used commands, and is organised 

for easy access to tabs in Outlook. To hide/minimise the ribbon, click on the 

following button. . 

3. Folder Pane. The Folder Pane allows easy navigation of Outlook items, 

and changes depending on what view you are in. For example, when in 

your Calendar, you will see a different Folder Pane than when you are in 

the Mail view.  

4. Message list. The message list lists your e-mail messages depending on 

which folder you are looking in, for example the inbox or sent items.  

5. Reading Pane. The Reading Pane shows a preview of each selected 

message.  

6. Peek. (Navigation bar). Peek allows you to quickly preview the various 

Outlook elements by hovering your mouse over each one. 

 

Outlook 2016 interface 

 

8.3 USING THE NAVIGATION BAR 

 Concepts 

A well-organised Navigation bar can help users save time in dealing with mails, 

tasks and contacts. Using the Navigation bar in Microsoft Outlook, you can 

navigate directly to the folder that contains the files you are interested in. 
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  Steps 

Use the Navigation bar to switch panes. 

Steps Practice Data 

1. Select the Calendar button to display the Calendar 

pane. 

The Calendar pane appears. 

Click   

2. Select the People button to display the People pane. 

The Contacts pane appears. Click  

3. Select the Tasks button to display the Tasks pane. 

The Tasks pane appears. Click  

4. Select the Mail button to display the Mail pane. 

The Mail pane appears. Click  

5. Select the . . . button to display the Folder pane. 

The Folder pane appears. Click  and click 

Folders. 
 

Practice the Concept: Click on the View tab. In the Layout group, click Folder 

Pane. A pull-down menu will be displayed, from which you can select the type of 

display, like Normal, Minimized, or Off. 

 

8.4 CUSTOMISING THE NAVIGATION BAR 

 Concepts 

If you don’t use an Outlook view, such as Tasks, you can remove it or any of the 

views from the Navigation Bar. You can also change the order of the Outlook 

views on the Navigation Bar. 

 

Navigation bar 

  Steps 

Customise the Navigation bar. 
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Steps Practice Data 

1. Click the  button the Navigation bar. 

 

Click to  

2. Click Navigation Options. 

The Navigation options dialog box appears. 

Click Navigation Options 

3. Change the number for Maximum number of visible 

items. 

This will reduce the number of item displayed on the 

navigation bar. 

 

Reduce the Maximum number 

of visible items to 3 

4. Select Move Up or Move Down as needed. 

The selected button moves up or down accordingly. 

Click Move Down one time 

5. Select OK. 

The Navigation Options dialog box closes and the 

changes are applied. 

Click OK 

 
 

8.5 USING MICROSOFT OUTLOOK HELP 

 Concepts 

If you need assistance on any Outlook topic or task, you can use Outlook’s 

extensive Help facility. You can get help using the Help command. 

When you access help by hitting the F1 button Microsoft opens the Outlook Help 

window. Microsoft Help searches both online and offline sources to provide 

assistance and training, and answer your questions about Office products. To get 

help, you can type your keywords into the search box and select the search 

button. You can also use the Tell me what you want to do search bar located 

along the top of the Outlook ribbon, which is a more comprehensive search 

feature.  

 

8.6 USING THE FOLDER PANE 

 Concepts 

You read and work with your messages in the Folder pane. All folders formatted 

to contain messages appear in here. The default mail folders include Inbox, Sent 
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Items, Outbox, Drafts, and Deleted Items. Depending on your configuration, 

Outlook contains a Junk E-mail folder. 

 Inbox - folder in which e-mails received by an individual are stored. 

 Sent Items – Items/messages that have been sent will be saved in the Sent 

Items folder. 

 Outbox – Sometimes, your sent mail may move to your Outbox folder but not 

move to your Sent Items folder when you are working offline or do not have a 

network connection. 

 Drafts - If you do not have the time to finish a message, or you need to add 

something to a message before sending it, you can save a draft version of it 

and send the final version later. When you save a message, it is automatically 

saved in the Drafts folder and is not sent.  

 Deleted Items - Items that you delete are moved to the Deleted Items folder, 

but are not permanently deleted until that folder is emptied. These contents 

take up part of your mail account storage quota.  

 Junk E-mail - Any message that is caught by the junk e-mail filter is moved to 

a special Junk E-mail folder. 

  Step 

 Use the Folder pane. 

 Steps Practice Data 

1. Select the Mail button on the Navigation bar. 

The Folder pane appears. 

Click Mail 

2. Select the desired folder. 

The contents of the folder appear. 

Click Inbox 

 
 

8.7 CREATE AN E-MAIL 

 Concepts 

Messages are sent to the addresses you enter in the To and Cc (carbon copy) 

field. You can type a recipient’s name or address in the To or Cc boxes or use the 

To and Cc buttons to access the names and e-mail addresses of contacts added 

to your Address Book. 

  Steps 

If necessary, display the Folder pane. 
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Steps Practice Data 

1. Select the New E-mail button on the toolbar. 

The Message window opens with the insertion point in 

the To box. 

Click  

2. Type the name or address of the primary recipient. 

The name or address of the recipient appears in the 

To box. 

Type a name or address 

(e.g. a fellow student) 

3. Select the Cc box. 

The insertion point appears in the Cc box. 

Press [Tab] 

4. Type the name or address of the carbon copy 

recipient. 

The name or address of the recipient to whom the 

carbon copy will be delivered appears in the Cc box. 

Type the name or address 

(e.g. another fellow students) 

5. Select the Subject box. 

The insertion point appears in the Subject box. 

Press [Tab] 

6. Type the subject of the message. 

The subject appears in the Subject box. 

Type Communicating 

through Outlook 

7. Select the message box. 

The insertion point appears in the message box. 

Press [Tab] 

8. Type the body of the message.  

The text appears in the message box. 

Type Outlook allows you to 

send messages and 

schedule meetings. 

9.  Perform a spell check on the e-mail. 

The e-mail will be proofread with suggestions for any 

mistakes. Click OK when complete.  

Go to the Review tab and 

click Spelling & Grammar 

10. Select the Send button on the toolbar. 

The message is sent to the appropriate recipients or 

stored temporarily in the Outbox folder. 
Click  

 

This message is sent without priority. To change the importance level of the 

message, select High Importance in the Tag group of the Message tab. 

 

You can carry out the same functions as listed under the Cc instructions for the 

Bcc (Blind carbon copy) feature, but you may need to enable this. To enable the 

Bcc feature, in the message window select the Options tab, click the Bcc option 

in the Show Fields group, and close the new message. 
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Tip: You can copy and paste text into the body of an e-mail by selecting the text 

you wish to copy, right-clicking and selecting Copy. Then open the location where 

you want to paste the text and on the Message tab click the Paste button in the 

Clipboard group. 

 

8.8 PERFORMING A MANUAL SEND/RECEIVE 

 Concepts 

If you have a poor Internet connection or are experiencing performance issues 

with your desktop application, e-mails may not come into your inbox or send from 

your outbox when they should have done. Performing a manual Send/Receive 

can help push through incoming/outgoing e-mails.  

  Steps 

Perform a manual Send/Receive. 

 

Steps Practice Data 

1. Select the Send/Receive tab. 

The Send/Receive commands are displayed. 

Click Send/Receive 

2.  Select Send/Receive All Folders. 

Click  

 

8.9 OPENING AN E-MAIL MESSAGE 

 Concepts 

Opening a new e-mail is often the beginning of conversation between people.  

  Steps 

To read a message in a mail folder: 

 

If necessary, display the Inbox folder and the Reading Pane. 
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Steps Practice Data 

1. Select a message header in the message list & 

double click. 

The message appears in the Reading Pane. 

Double Click on the e-mail 

message 

 

To close the e-mail message, click on the  button. 

 

8.10 REPLYING TO A MESSAGE 

 Concepts 

You can choose to reply to the sender of the message or to the sender and all 

other message recipients. When you reply to a sender, the sender’s e-mail 

address is automatically entered in the To field. 

Replies sent to you display the text RE: and the original message subject in the 

Subject column in your Inbox folder. 

  Steps 

 Reply to a message. 

 

 Open the Inbox folder. 

Steps Practice Data 

1. Select or open the message to which you want to 

reply. 

The message appears in the Reading Pane or opens 

in a Message window. 

Click a message in your inbox 

2. Select the Reply button to reply to the message 

author or the Reply to All to reply to all message 

recipients. 

The RE: Message window opens with the address 

and subject boxes completed and the insertion point 

in the message box. 
Click   

3. You will now be able to type the message. 

The reply appears in the message box. 

Type your reply in the 

message box 

 

Once a reply is typed you can hit Send to send the reply. Close the message 

without sending. 
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8.11 FORWARDING A MESSAGE 

 Concepts 

Forwarded messages include all the header information in the original message 

plus the message body. You can also add your own comments, which appear at 

the top of the message. You can forward messages to other recipients directly 

from the Reading Pane or the Message window. 

  Steps 

 Forward a message to another recipient. 

 

 If necessary, open the Inbox. 

 

Steps Practice Data 

1. Select or open the message you want to forward. 

The message appears in the Reading Pane or opens 

in a Message window. 

Click the message 

2. Select the Forward button. 

The FW: Message window opens with the subject 

completed and the insertion point in the To box. Click  

3. You can put in the name of any recipient you wish to 

forward a message to. 

The name or address appears in the To box. 

Type the name or address of 

the desired recipient 

4. Select the message box. 

The insertion point appears in the message box. 

Click in the message box 

5. Type the text you want to include with the forwarded 

message, if desired. 

The text appears in the message box. 

Type text into the message 

box 

6. Select the Send button. 

The FW: Message window closes and the message is 

forwarded to the recipient. 
Click    
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8.12 CHANGING THE READ STATUS OF A MESSAGE 

 Concepts 

In your Inbox, unread messages have bold subjects and are highlighted with a 

blue vertical line. After you click on a message, and then click on something else, 

the message is no longer bold, indicating that it has been read. 

However, you may want to change the status of read message back to unread, if 

for example you haven’t had time to properly deal with the message, and need to 

return to it.  

 

E-mail Status  

 

Icon 

Unread message 

 

Replied to message 

 

High Importance Message 

 

Has Attachment 

 

Flagged by Sender 

 

Flagged message 

 

  Steps 

 Change the read status of a message. 

 

 Open the Inbox folder. 

Steps Practice Data 

1. Select the message with the read status you want to 

change. 

The message is selected. 

Click a message 



ECDL Online Essentials Lesson 8 - Sending E-mail 

© 2016   Page 77 

Steps Practice Data 

2. Select the Home tab. 

The Home commands appear on the ribbon. 

Click Home 

3. Select the Unread/Read button in the Tags group.  

The message symbol, message header, and Unread 

Mail Search Folder change accordingly. 

Click  

 

Notice that the number next to the Inbox folder and Unread Mail Search Folder 

increases by 1. 

 

8.13 FLAGGING A MESSAGE 

 Concepts 

You can insert a follow-up flag next to a message as a reminder or to call attention 

to the item. You can also send a message with a flag as a reminder for the 

message recipient.  

When a message is flagged, a colour is applied to the flag and the flag 

background in the Flag Status column in the message list, making it easier to 

spot flagged messages.  

  Steps 

 Flag a message. 

 

 Display the Mail pane and open the Inbox folder. 

Steps Practice Data 

1. Select a message to flag.  

The message is highlighted. 

Click on a message 

2.  Select Follow Up. 

     The Follow Up dropdown menu displays. 

On the Home tab click Follow 

Up 

3. Flag the message.  

A flag appears in the message’s Flag Status. 

Click Flag Message 
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Steps Practice Data 

4.  To unflag a message, select a message to unflag, and 

select Follow Up. 

     The Follow Up dropdown menu displays. 

On the Home tab click Follow 

Up 

5. Unflag the message.  

A flag is removed from the message’s Flag Status. 

Click Clear Flag 

 

8.14 PRINTING FROM THE MESSAGE WINDOW 

  Steps 

 Print a message from the Message window. 

  

 If necessary, open the Inbox folder. 

Steps Practice Data 

1. Open the message you want to print. 

The message opens in the Message window. 

Double-click the message 

2. Select the File tab. 

The File backstage appears. 

Click File 

3. Select Print. 

The print preview of the page is displayed.  

Click Print 

4.  Select the Print Options button.  

The print dialog box is displayed. Click  

5. Select options and change settings as desired. 

The options are selected or the settings are changed 

accordingly. 

Click Number of copies  

to 2 

6. Select Print. 

The Print dialog box closes, and Outlook prints the 

message according to the settings and options 

selected. 

Click Print 

 

Close the Message window. 
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8.15 REVIEW EXERCISE 

 
1. The ________________ is found in the upper-left corner of Outlook, containing 

commonly used commands for Outlook.  
a. Navigation Pane 
b. Quick Access Toolbar 
c. To-do Bar 
d. Ribbon 

 
 

2. True or False: Items moved to the Deleted Items folder are not permanently deleted.  
a. True 
b. False 

 
 

3. Items that are in the process of sending but have not been sent are stored in what 
folder: 

a. Sent Items 
b. Outbox 
c. Drafts 
d. Junk E-mail 

 
 

4. Identify what each of these symbols stand for: 

a.  

b.  

c.  

d.  



 

 

LESSON 9 -  

WORKING WITH E-MAIL COMPONENTS  

In this section, you will learn about: 

 

 Attaching a file to a message 

 Using the attachment viewer 

 Saving a file attachment 

 Creating a signature 

 Selecting default signatures  

 Inserting a signature  

 Using the out of office feature 

 Creating a contact group 

 Using a contact group 

 Deleting a contact 
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9.1 ATTACHING A FILE TO A MESSAGE  

 Concepts 

Distributing a file by e-mail is a common practice and is a useful method of 

sharing information with colleagues, for example.  

  Steps 

 Attach a file to a message. 

 

You want to create a new message addressed to yourself and attach a document.  

 

Steps Practice Data 

1. Select the Attach File button in the Include group. 

The Insert File dialog box is displayed. 

Click Attach File 

2. Select the drive where the file is located. 

A list of available folders appears. 

Navigate to the relevant folder 

3. Open the folder where the file is stored. 

A list of available files appears. 

Double-click to open the 

folder 

4. Select the file that you want to send. 

The file is selected. 

Click the relevant file (a 

document) 

5. Select Insert. 

The Insert File dialog box closes and an icon 

representing the file and the file name appears in the 

Attached box. 

Click Insert 

 

Click in the message box and type a message. Send the message to yourself. 

 

Tip: To remove an attachment from an e-mail, right-click the attachment and click 

Remove.  
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9.2 OPENING AN ATTACHMENT 

 Concepts 

If someone sends you an attachment, its presence is indicated with a paperclip 

icon.  

  Steps 

 Use the Attachment Previewer. 

Steps Practice Data 

1. Select Inbox in the Navigation (Folder) pane. 

The Inbox appears. 

Click Inbox 

2. Display a message with an attachment in the 

Reading pane. 

The message appears in the Reading pane. 

Click the message you sent to 

yourself with an attachment 

3. Select the attachment icon. 

The right-click menu is displayed. 

Right-click the attachment 

4. Select Preview. 

A warning is displayed regarding previewing files from 

a trustworthy source. 

Click Preview 

 

Click on the message icon beside the attachment filename to display the message 

body. 

 

9.3 SAVING A FILE ATTACHMENT 

 Concepts 

If you receive an attachment in an e-mail you may wish to save it to your computer 

or storage device.  

You can see that there is an attachment because a paperclip icon  is displayed.  

  Steps 

 Save a file attachment. 
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Steps Practice Data 

1. Display the message with an attachment in the 

Reading Pane or open it in a message window. 

The message appears in the Reading Pane or in a 

message window. 

Click the message you sent to 

yourself with an attachment 

2. Right-click the attachment icon. 

A dropdown menu appears. 

Right-click the attachment 

3. Select Save As. 

The Save As dialog box opens with the text in the 

File name box selected. 

Click Save As 

4. If you wish you can rename the file.  

The file name appears in the File name box. 

Rename the file 

5. Select the drive where you want to save the folder. 

A list of available folders appears. 

Click the desired drive 

6. Open the folder where you want to save the file. 

The desired folder is selected. 

Double-click to open the 

desired folder 

7. Select Save. 

The Save As dialog box closes, and the file 

attachment is saved in the selected folder. 

Click Save 

 

To delete the attachment from an e-mail, right click on the attachment icon in the 

e-mail, select Delete. 
 

9.4 CREATING A SIGNATURE 

 Concepts 

You can use the Signature feature to automatically add a signature to each new 

message you create, or each reply and forwarded message. A signature can 

include formatted text, e-mail addresses, and hyperlinks. Furthermore, you can 

create multiple signatures. You can set a separate automatic signature for new 

messages and another for replies and forwarded messages. In addition, you can 

also select separate automatic signatures for different e-mail accounts. 
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Signatures and Stationery 

  Steps 

 Create a signature. 

Steps Practice Data 

1. Select the File tab. 

The Backstage view appears. 

Click File 

2. Select the Options command. 

The Options dialog box opens. 

Click Options 

3. Select Mail. 

The Mail options page appears. 

Click Mail 

4. Select Signatures... 

The Signatures and Stationery dialog box opens. 

Click Signatures... 

5. Select New. 

The New Signature dialog box opens with the text in 

the Type a name for this signature. 

Click New 

6. Type a name for the signature. 

The text appears in the Type a name for this 

signature box. 

Type John 
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Steps Practice Data 

7. Select OK. 

The Type a name for this signature box is closed. 

Click OK 

8. Type the text you want to appear in the first line of the 

signature. 

The text appears in the Edit signature pane. 

Type John Doe 

9. Press [Enter] to add a new line. 

The insertion point moves to the next line in the Edit 

signature pane. 

Press [Enter] 

10. Type the desired signature text, pressing [Enter] as 

needed to add additional lines. 

The text appears in the Edit signature pane. 

Type: 

John Doe 

General Manager  

11. Select the text you want to format. 

The text is selected. 

Drag to select all the 

signature text. 

12. Select the desired formatting options. 

The desired formatting options are selected. 
Click  

13. Select Save. 

The Signature is saved. Click  

14. Select OK. 

The Signatures and Stationery dialog box closes. Click  

15. Select OK. 

The Options dialog box closes. Click  

 

When you now create a new message, the signature should be automatically 

inserted. 

 

9.5 INSERTING A SIGNATURE 

  Steps 

 If your signature does not insert automatically, or if you have more than one 

signature to choose from, you can insert a signature manually in a message.  

 



Lesson 9 – Working With E-mail Components ECDL Online Essentials 

Page 86   © 2016 

Steps Practice Data 

1. In a message, select the Insert tab. 

The Insert tab opens. 

Click Insert 

2. In the Include group, select the Signature button. 

The Signature menu appears. 

Click Signature 

.  

3. Select the desired signature. 

The signature text is inserted into the message box. 

Click the desired signature 

 

9.6 USING THE OUT OF OFFICE  

 Concepts 

You can use the Out of Office to create Automatic Replies. Automatic Replies are 

messages that are automatically sent to anyone who sends you a mail while you 

are out of the office. You can create your own custom message, for example 

informing people who mail you that you are out of the office on a business trip. 

 

When you turn on the Automatic Replies feature, Outlook replies automatically to 

messages received from other people. 

 
Automatic Replies 
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  Steps 

If necessary, open the Inbox. 

Steps Practice Data 

1. Select the File tab. 

The Backstage opens. 

Click File 

2. Select the Info page. 

The Info page displays. 

Click Info 

3. Select the Automatic Replies button from the Info 

page. 

The Automatic Replies dialog box opens. 

Click  

4. Select Send automatic replies. 

Send automatic replies option is selected. 

Click Send automatic replies. 

5. Type the desired autoreply message. 

 

Type I shall be out of the 

office until next Friday. 

Please call Jane Doe for 

assistance. 

7. Select OK. 

The Automatic Replies dialog box closes. Click  

 

 

9.7 CREATING A CONTACT GROUP 

 Concepts 

Use a contact group (formerly called a “distribution list”) to send an e-mail to 

multiple people such as a project team — or even just a group of friends — 

without having to add each name each time you want to write them.  

  Steps 

Create a contact group / distribution list. 

 

If necessary, open the People pane from the navigation bar. 

 



Lesson 9 – Working With E-mail Components ECDL Online Essentials 

Page 88   © 2016 

Steps Practice Data 

1. Select People from navigation bar. 

The contacts are displayed. 

Click People  

2.  Select the Home tab.  Click Home 

3. Select New Contact Group from the New group. Click New Contact Group 

4. Enter the name of the contact group from the contact 

group tab. 

The desired name appears in the Name box. 

Type Expo team 

5. Select the Add Members button in the Members 

group. 

  

Click Add Members 

 

5. Select the desired address book or contact list. 

The names in the selected address book appear in 

the Select Names dialog box. 

Click From Outlook 

Contacts 

6. Select the first name you want to add to the 

distribution list. 

The first name is selected. 

Click the first name you want 

to add 

7. Select the Members button. 

The selected name appears next to the Members 

button. 

Click Members  

8. Continue to add names to the distribution list as 

desired. 

The selected name appears next to the Members 

button. 

Add another contact 

9. Select the OK button. 

The Select Members dialog box closes, and the 

names appear in the Distribution List window. 

Click  

10. Select the Save and Close button. 

The Distribution List window closes, and the new 

distribution list is saved and appears in the Contacts 

folder. 

Click Save & Close 

 

Notice that the name Expo team appears in bold with an icon of two people to its 

right in the People pane. 
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9.8 USING A CONTACT GROUP TO CREATE MESSAGE 

  Steps 

Use a contact group. 

 

If necessary, create an Expo team contact group with three names from one of 

your address books. 

 

Create a new message. 

Steps Practice Data 

1. Enter the contact group list name in the desired 

recipient field. 

The contact group name display in the recipient field. 

Select the To button in the 

message header and show 

the names from the Contacts 

list 

 

2. The distribution list name appears in the recipient 

field with an expand box (plus sign). 

Double-click the Expo team 

entry and select OK 

3. To expand the list, click the plus sign for the 

distribution list. 

An Expand List message box opens warning that 

once you expand the names, you will not be able to 

collapse them. 

Click  Expo team 

4. Select the OK button. 

The Expand List message box closes and the 

distribution list expands to display the e-mail address 

of each member. 

Click  

5. Compose the message and send. 

The e-mail is sent. 

Click Send 

 
To update a contact list:  

 

Steps Practice Data 

1. Select the contact group you want to update.  

The contact group will be selected. 

Double-click the contact 

group 
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Steps Practice Data 

2. Enter or delete required fields.  Use the provided fields to 

update 

3. Save the changes you have made.  

The updated contact group will be saved. 

Click Save & Close in the 

Actions group under the 

Contact Group tab 

 

9.9 DELETING A CONTACT 

  Steps 

Delete a contact. 

 

If necessary, open the People pane. 

 

Steps Practice Data 

1. Select the contact you want to delete. 

The contact is selected. 

Click the contact 

2. Click the Delete button in the Delete group. 

The contact is deleted. 

Click  

 

Practice the Concept: Delete the Expo team contact group. 

 

Steps Practice Data 

1. Select the contact group you want to delete. 

The contact group is selected. 

Click the Expo team 

contact group 

2. Click the Delete button in the Delete group. 

The contact group is deleted. 

Click  
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9.10 REVIEW EXERCISE 

 

1. An e-mail sent automatically to anyone who e-mails you while unavailable is called 

_______________. 

a. A signature 

b. An Out of Office reply 

c. A Draft  

d. An IM 

 

2. A contact group is a list of people that you can e-mail in one go without having to add 

an address each time you wish to message them: 

a. True  

b. False 

 

3. Which of the following cannot be included in an e-mail signature: 

a. Formatted text 

b. Files 

c. Hyperlinks 

d. E-mail address 

 

 



 

 

LESSON 10 -  

ORGANISING E-MAILS  

In this section, you will learn about: 

 

 Arranging and grouping messages 

 Sorting messages 

 Working with custom views 

 Using search 

 Creating a new folder 

 Moving a message to a different folder 

 Deleting a folder 

 Deleting a message 

 Emptying the deleted items folder 

 Recovering deleted items 

 Using the junk e-mail folder 
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10.1 ARRANGING AND GROUPING MESSAGES 

 Concepts 

Messages headers can be displayed in a different order by selecting one of the 

pre-set arrangements. Each arrangement groups and sorts the messages based 

on a message property (field). The default arrangement of messages is by Date. 

However, messages can also be arranged by other properties.  

 

View selector 

  Steps 

Arrange and group messages. 

 

If necessary, display the Inbox with the Reading Pane on the right. You should 

have at least two messages in your Inbox. 

 

Steps Practice Data 

1. Select the View tab.  

View tab is displayed. 

Click View 

2. In the Arrangement group, select the desired 

arrangement property. 

The messages are arranged by the selected property. 

Click Size 

 

Practice the Concept: Select the View tab, the Arrangement group, and the 

Show in Groups command to enable message grouping. 
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10.2 SORTING MESSAGES 

 Concepts 

After selecting a property for arranging messages, you may want to change the 

sort order. Messages can be sorted in ascending or descending order by criteria 

including name, date or by size. 

  Steps 

Sort messages. 

 

If necessary, display the Inbox folder with the Reading Pane on the right. You 

should have at least two messages that are arranged by Date. If you can’t view 

the Newest on top text in the sort order field button, widen the message list by 

dragging the border between the message list and the Reading Pane. 

 

Steps Practice Data 

1. Select the View tab. Click View 

2. To change the sort order of the messages, select the 

sort order field button at the top of the message list. 

The messages are rearranged in the opposite sort 

order. 

Click Reverse Sort 

 

Notice that the Oldest on top sort order is now selected. Arrange the messages 

by their dates with the newest messages on top. 

 

10.3 WORKING WITH CUSTOM VIEWS  

 Concepts 

You can customise a view in a folder to make it easier to work with the folder 

items. You can remove and add inbox headings such as From, Subject, Date 

Received and more. The types of information and formatting displayed in a view 

can be customised using the Field, Group By, Sort, Filter, Other Settings, 

Automatic Formatting, and Format Columns buttons in the Customize View 

dialog box. Each button opens a dialog box where you can select the options you 

want to modify. 
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The options available in the Customize View dialog box change depending on the 

type of view you are modifying. For instance, when modifying a card view, the 

Group By and Format Columns buttons are not available and the options on the 

Other Settings dialog box differ from those available for a table view. Furthermore, 

if you are modifying a table view, you can often bypass the Customize View dialog 

box by using the shortcut menu for the column headings in the view. The Show 

Fields and Other Settings dialog boxes contain options for displaying items in a 

multi-line format. 

 

 
Current View 

 

 
Advance View Settings 
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Column Options 

To select headings you wish to add to the folder select a field in the left column 

and click Add ->, and to remove from the current folder select a field in the right 

column and click <- Remove. Once you have chosen the headings you wish to 

display in the folder, click OK to apply settings. 

  Steps 

Format a column in a tabular view. 

 

If necessary, select the View tab.  

Steps Practice Data 

1. Select the View Settings button in the Current View 

group. 

The Advanced View Settings List appears. 

Click  

2. Select the Format Columns command. 

The Format Columns dialog box opens. 

Click Format Columns 

3. Select the field you want to format in the Available 

fields list. 

The field name appears in the Label text box. 

Click Subject 
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Steps Practice Data 

4. Select the Format list. 

A list of available formats opens. Click Format  

5. Select the desired format, if necessary. 

The desired format appears in the Format box. 

Click Text, if necessary 

6. To rename the field, select the text in the Label box. 

The text is selected. 

Press [Tab] 

7. Type the new field label. 

The text appears in the Label box. 

Type Message Header 

8. Select the desired Width option. 

The desired option is selected. 

Follow the instructions 

shown below the table 

before continuing on to the 

next step 

9. Select the desired Alignment option. 

The desired option is selected. 
Click  Center 

10. Select OK. 

The Format Columns dialog box closes and the 

formatting is applied to the column. 

Click  

 

Select the Specific width option, if necessary, and enter 25 in the characters 

box. 

Tip: You can also minimise the ribbon by right-clicking anywhere along the ribbon 

and selecting Collapse the Ribbon. To then restore the ribbon, select one of the 

four tabs along the top (Home, Send / Receive, Folder, View), right-click on the 

ribbon and untick Collapse the Ribbon. 

 

10.4 USING SEARCH  

 Concepts 

If you need to locate an e-mail quickly but don’t wish to scroll through an entire 

folder, you can use the search bar found at the top of the Mail pane. This allows 

you to search by sender, keywords and subject. If you are not sure what folder the 

e-mail is in you can perform an overall search throughout your Outlook account.  

  Steps 

Use Search to find e-mails. 
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Steps Practice Data 

1. Select the Mail pane. 

The Mail folder is displayed. 

Click Mail 

2. Select the Instant Search box at the top of the inbox. 

The insertion appears in the Instant Search box. 

Click 

 

3. Type the first letter of the required search text. 

The search text is displayed in the Search Box and 

the results are highlighted. 

Type the first letter of the 

required search text 

4. Continue typing further characters until the required e-

mail is visible. 

The search text is displayed in the Search Box and 

the results are highlighted. 

Type additional characters 

5. Select the required e-mail. 

The e-mail is displayed in the Reading pane. 

Click the required e-mail 

 

Narrow your search results 

If you can’t find what you’re looking for, use the search tools on the ribbon to narrow 

down your search. When you click the search box, you can select a scope option on 

the left side of the ribbon. Once you decide your scope, you can then refine your 

search further by selecting an option such as the subject line, the sender, or the e-

mail’s content. 

 

 

 

10.5 CREATING A NEW FOLDER 

 Concepts 

You can create new folders to help you organise Outlook items. For example, you 

can create a folder for a specific customer and keep all the messages relating to that 

customer in the folder. Folders can contain only one type of Outlook item. 
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New folders can be created as a folder directly under your personal folder or as a 

subfolder under one of the existing folders, such as the Inbox folder. 

 

Creating a new folder 

  Steps 

 Create a new folder. 

Steps Practice Data 

1. Select the Folder tab. 

The Folder ribbon appears.  

Click Folder 

2. Select the New Folder button in the New group. 

The Create New Folder dialog box opens with the 

insertion point in the Name box. 

Click  

3. Type the name of the new folder. 

The folder name appears in the Name box. 

Type Expo Agenda. 

4. Select the Folder contains list. 

A list of item types appears. Click Folder contains  

5. Select the type of items you want the folder to contain. 

The selected item type appears in the Folder 

contains box. 

Click Mail and Post Items 
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Steps Practice Data 

6. Expand the desired folder in the Select where to 

place the folder list box, if necessary. 

The desired folder expands. 

Scroll as necessary and click 

 Mailbox, if necessary 

7. Select the folder location for the new folder. 

The folder location is selected. 

Click Inbox 

8. Select OK. 

The Create New Folder dialog closes and the folder is 

added to the selected location. 

Click  

 

10.6 MOVING A MESSAGE TO A DIFFERENT FOLDER 

 Concepts 

You can move messages between folders at any time. You can select several 

messages to move at the same time by holding the [Ctrl] key and clicking the 

desired messages. If you group messages, you can move the whole group by 

selecting the group heading. 

  Steps 

Move a message to a different folder. 

 

If necessary, open the Inbox folder. The Inbox should contain a subfolder called 

Expo Agenda. If necessary, select the Home tab.  

 

Steps Practice Data 

1. Select the message that you want to move. 

The message to be moved is selected.  

Click on the message to be 

moved.  

2. Select the Move button in the Move group.  

The list of available folders is displayed. 

Click  

3. Select the folder you want to move the message to. 

The submenu closes and the message is moved to 

the selected folder.  

Click Expo Agenda 
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10.7 DELETING A FOLDER 

 Concepts 

You can delete a folder you have created when you no longer need it. You can 

delete an empty folder or a folder that still contains items. You cannot, however, 

delete the default Outlook folders. Deleted folders are moved to subfolders in the 

Deleted Items folder, where they remain until you empty the Deleted Items 

folder. 

  Steps 

Delete a folder. 

 

Display the Mail pane and expand the Inbox folder, if necessary. 

Steps Practice Data 

1. Right-click the folder you want to delete. 

The folder is selected. 

Right-click Expo Agenda  

2. Select the Delete Folder command. 

A Microsoft Office Outlook warning box opens, 

prompting you to confirm the deletion. 

Click Delete Folder 

3. Select Yes to confirm the deletion. 

The Microsoft Office Outlook warning box closes and 

the current folder and its contents are deleted. 

Click  

 

10.8 DELETING A MESSAGE 

 Concepts 

You can delete messages from any folder. You should periodically delete 

messages from your mail folders to keep them manageable. When you delete an 

item from a folder, it is sent to the Deleted Items folder. 

  Steps  

Delete a message. 

 

Display the Mail pane and expand the Inbox folder, if necessary. 
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Steps Practice Data 

1. Select the message you want to delete. 

The message is selected. 

Click the first message in the 

message list 

2. Click the Delete button. 

The message is removed from the folder and moved 

to the Deleted Items folder. 

Click  

 

10.9 EMPTYING THE DELETED ITEMS FOLDER 

 Concepts 

As you delete messages, they are sent to the Deleted Items folder. Deleted 

messages remain in this folder until it is emptied. You should empty this folder on 

a regular basis to make it easier to use and to conserve disk space. 

  Steps 

Empty the Deleted Items folder. 

 

If necessary, delete a message. 

 

Steps Practice Data 

1. Right-click on the Deleted Items folder in the Folder 

pane.  

Right-click Deleted Item 

2. Select the Empty Folder command. 

A Microsoft Office Outlook warning box opens, 

prompting you to verify the deletion. 

Click Empty Folder 

3. Select Yes. 

The Microsoft Office Outlook warning box closes and 

the items are deleted from the Deleted Items folder. 

Click  

 

 Open the Deleted Items folder, if necessary, to verify that it is empty. 
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10.10 RECOVERING DELETED ITEMS 

 Concepts 

If your e-mail server is a Microsoft Exchange Server, you can recover items you 

emptied from the Deleted Items folder. Items emptied from the Deleted Items 

folder appear in the Recover Deleted Items From - Deleted Items dialog box. 

Deleted items are listed by the date they were deleted in ascending order, with 

deleted folders displayed first.  

  Steps 

If necessary, select two messages from the Sent Items folder and delete them. 

Then empty the Deleted Items folder. 

 

Click the Send/Receive button to perform a manual send and receive. 

 

Steps Practice Data 

1. Select the Folder tab. 

The Folder ribbon is displayed.  

Click Folder 

2. Select the Recover Deleted Items button in the 

Clean Up group 

The Recover Deleted Items dialog box is displayed. 

Click  

 

10.11 USING THE JUNK E-MAIL FOLDER 

 Concepts 

The Junk E-mail Filter evaluates each incoming message based on several 

factors, including the content of the message. 
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Junk Mail  

  Steps 
 

Work with Junk E-mail. 

 

Display the Mail pane. 

Steps Practice Data 

1. Open the Junk E-mail folder. 

The Junk E-mail folder opens. 
Click   

2. Right-click a message that you want to mark as not 

junk e-mail. 

A shortcut menu opens. 

Right-click the message 

3. Point to the Junk command. 

The Junk submenu opens. 

Point to Junk 

4. Select the desired command. 

The Not Junk dialog box opens. 

Click Not Junk 

5. Select the desired options. 

The options are selected. 
Click  Always trust e-mail 

from “name” to select it, if 

necessary 

6. Select OK. 

The Mark as Not Junk dialog box closes and the e-

mail message is processed accordingly. 

 

 

Click  
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The message is removed from the Junk E-mail folder and returned to the Inbox 

folder. 
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10.12 REVIEW EXERCISE 
 

1. List four options for organising and arranging messages. 

__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 

2. You can delete all folders in Outlook: 

a. True  

b. False 

 

 

3. Create a new message with the subject called Test and the body of the message 

Test. Send the e-mail to yourself. After you receive the e-mail, permanently delete 

both e-mails from the Inbox and Sent folder.  

 

4. E-mails that end up in the Junk Email folder are always junk / spam: 

a. True 

b. False 

 
 



 

 

LESSON 11 -  

USING CALENDAR  

In this section, you will learn about: 

 

 Using the calendar pane  

 Navigating the calendar  

 Scheduling a new appointment  

 Scheduling a resource for a meeting 

 Accepting/declining meeting requests 

 Proposing a new meeting time 

 Updating a meeting 

 Cancelling a meeting 
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11.1 USING THE CALENDAR PANE  

 Concepts 

You can enter and track appointments, meetings, and tasks using the Microsoft 

Outlook Calendar component. You can use Calendar in conjunction with other 

components of Outlook to help manage all of your information. Calendar items 

are saved in the Calendar folder, which you can access through the Calendar 

pane. You can open the Calendar pane from the Navigation bar. 

 

The Calendar pane 

  Steps 

 Open the Calendar to view the Calendar folder. 

Steps Practice Data 

1. Click the Calendar button on the Navigation bar. 

The Calendar pane opens displaying the Calendar 

folder. 

Click  
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11.2 NAVIGATING THE CALENDAR 

 Concepts 

The default calendar view is the Day/Week/Month view, with the Day view 

selected. Other view options available from the buttons on the Standard toolbar 

include Work Week, Week, or Month view. You can use Date Navigator or the 

Today button to display the current date. However, in Outlook 2016 the number of 

calendar months is limited in Date Navigator. This means you cannot view more 

months in Date Navigator of To-Do Bar through the above two methods. But you 

can view more months in Calendar Folder Pane by dragging the split bar. 

  Steps 

Navigate the Calendar. 

 

If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. To view the appointments for a specific date, click the 

date in the Date Navigator. 

The date changes at the top of the scheduling area 

and the appointments for the date appear. 

Click tomorrow’s date in the 

Date Navigator 

2. To view the appointments for a consecutive range of 

dates, drag the range of dates in the Date Navigator. 

The appointments for the selected range of dates 

appear in the scheduling area. 

Drag from Monday to Friday 

of this week in the Date 

Navigator 

3. To view the appointments for a non-consecutive range 

of dates, select the first date you want to display in the 

Date Navigator. 

The first date is selected in the Date Navigator and 

the appointments for that date appear in the 

scheduling area. 

Click the first Wednesday of 

the current month 

4. Hold [Ctrl] and click the additional dates you want to 

display. 

The appointments for all the selected dates appear in 

the scheduling area. 

Hold [Ctrl] and click the 

second Wednesday of the 

current month 
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Steps Practice Data 

5. To return the display to show only the appointments 

for one date, click the desired date in the Date 

Navigator. 

The appointments for the one date appear in the 

scheduling area. 

Click today’s date 

6. To scroll to another month, click the left or right scroll 

arrows at the top of the Date Navigator. 

The selected month appears in the Date Navigator. 

Click  next to the month 

name in the Date Navigator 

7. To change the way appointments appear in the 

scheduling area, select the Day, Work Week, Week, 

or Month button on the Standard toolbar. 

The appointment display in the scheduling area 

changes accordingly. 

Click Work Week 

 

Practice the Concept: Drag the vertical border between the Folder Pane and the 

scheduling area as far to the right as possible to display several columns of 

months in the Date Navigator. Return the width of the Folder Pane to display only 

one column of months in the Date Navigator. Click the Day button to return the 

Calendar to the day format. 

 

11.3 SCHEDULING A NEW APPOINTMENT 

 Concepts 

You can use the Calendar to schedule your appointments. Appointments are 

activities that do not involve notifying other people or scheduling resources. 

 

You schedule appointments in the Appointment window. This window allows you 

to enter a subject, location, and start and end times for an appointment, as well as 

make the appointment an all-day event. If the new appointment conflicts with 

another appointment, a message appears above the subject, indicating a conflict. 
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  Steps 

Schedule a new appointment. 

 

If necessary, open the Calendar pane. 

 

Steps Practice Data 

1. Select the date for the appointment you want to 

schedule in the Date Navigator. 

The date changes at the top of the scheduling area 

and the appointments for the date appear. 

Click the next business day in 

the Date Navigator 

2. Drag the half-hour time slots you want to allocate for 

the appointment in the scheduling area. 

The time slots are selected in the scheduling area. 

Drag from 9:00 am to 11:00 

am 

3. Click the New Appointment button on the Home tab. 

The Appointment window opens with the start and end 

times completed and the insertion point in the Subject 

box. 

Click New Appointment 

4. Type a subject for the appointment. 

The subject appears in the Subject box. 

Type Research for Global 

Proposal 

5. Select the Location box. 

The insertion point appears in the Location box. 

Press [Tab] 

6. Type a location for the appointment. 

The text appears in the Location box. 

Type Library 

7. Select the Categorize button in the Options group. 

A list of categories appears. 

Click 
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Steps Practice Data 

8. Select the category option you want to appear in the 

appointment’s info bar, the colour of which will also be 

used for this appointment in the calendar window. 

The appropriate option is selected.  

Click Purple Category 

9. Select the Reminder list. 

A list of reminder times appears. Click Reminder  

10. Select the desired time the alarm should warn you in 

advance of the appointment. 

The time is selected. 

Click 30 minutes 

11. Select the Show as list. 

The Show as list appears. Click Show as  

12. Select the option you want to appear in the 

appointment’s selected time slot when viewed by other 

users. 

The appropriate option is selected. 

Click Tentative 

13. Select the details box. 

The insertion point appears in the details box of the 

Appointment window. 

Press [Tab] 

14. Type details about the appointment. 

The text appears in the details box of the Appointment 

window. 

Type Review RFP and draft 

a rough outline for the 

development team 

15. Select the Save and Close button. 

The Appointment window closes, the new appointment 

is saved, and both the subject and location of the 

appointment appear in the designated time slot in the 

scheduling area. 

Click  

 

View the appointments in Month view. Then switch to Day view and display the 

current date. 

 

11.4 SCHEDULING A RESOURCE FOR A MEETING 

 Concepts 

You can schedule a resource for a meeting just as you would schedule a person. 

Resources include conference rooms and equipment, such as a projector. In order 

to schedule a resource, it must be set up with its own mailbox, usually by the 

system administrator. 
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The same scheduling rules that apply to a person apply to a resource. When 

scheduling a meeting, you invite the resource and, if the resource is free, it will 

accept the meeting. If the resource is not free, it will automatically reject the 

invitation. 

  Steps 

Schedule a resource for a meeting. 

 

Open the Calendar pane and display the schedule for the current day. 

Steps Practice Data 

1. Select the Home tab. 

The Home tab appears. 

Click Home 

2.  Select the New Items command and choose 

Meeting. 

The Meeting window opens. 

Click New Items and then 

Meeting 

3. Select Attendees from the To line. 

A new window appears. 

Click To… 

4. Select the desired resource. 

The desired resource is selected. 

Scroll as necessary in the 

Name list box and click the 

resource of choice 

5. Select Resources. 

The resource is added to the Required list box. 
Click Resources  

6. Add any other attendees or resources to the meeting. 

The attendee names or resources appear in the 

appropriate box. 

Select as necessary in the 

Name list box and add to 

the attendees or resources 

box 

7. Select OK. 

The Select Attendees and Resources dialog box 

closes and the selected attendees and resources 

appear in the All Attendees list in the Meeting dialog 

box. 

Click  

8. Type a subject for the meeting. 

The text appears in the Subject box. 

Type an appropriate subject 

title 

9. Select options as desired and then select the Send 

button. 

The Meeting window closes and the meeting requests 

are sent to the attendees and resources. 

Click Send 
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Having successfully setup a meeting, once you close the Meeting dialog box you 

will notice the meeting on your Calendar. 

 

To remove invitees or resources from a meeting, select the meeting from your 

calendar and use the backspace button to remove the appropriate invitees or 

resources. Click Send Update to update the meeting.   

 

11.5 ACCEPTING/DECLINING MEETING REQUESTS 

 Concepts 

As other users schedule meetings, you may receive meeting requests in your 

Inbox. You have the option of accepting, declining, or submitting a tentative 

response. You can respond to a meeting request from the Reading Pane or the 

Message window. When you select the Accept, Tentative, or Decline button, 

Outlook opens a warning box in which you have options to edit the response, 

send the response, or not send the response at all. 

 

Meeting requests are automatically added to your schedule as a tentative 

appointment when Outlook updates your Calendar or after you read the meeting 

request. If you accept the meeting, the meeting time changes to busy. If you 

decline the meeting, the meeting is removed from your schedule. 

 

  Steps 
 

Accept/Decline meeting requests. 

Steps Practice Data 

1. Select the Accept, Tentative, or Decline button as 

desired. 

A Microsoft Outlook warning box opens, prompting 

you for a selection. 

Click Accept 
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Steps Practice Data 

2. Select the desired option. 

The desired option is selected. 
Click  Send the 

response now. if 

necessary 

3. Select OK. 

The Microsoft Outlook warning box closes and the 

response to the meeting is sent. 

Click OK 

 

You should receive a message in your Inbox indicating you have accepted a 

meeting request. Select the message and view the message in the InfoBar. 

 

The meeting will no longer be tentative in the calendar after you have accepted it.  

 

11.6 PROPOSING A NEW MEETING TIME 

 Concepts 

If you would like to respond to a new meeting by proposing a new time, you can 

use the Propose New Time button to select a new time and respond to the 

invitation to the meeting. You can propose a new time from the Reading Pane or 

the Message window. 

  Steps 

Propose a new meeting time. 

 

Steps Practice Data 

1.  Select Meeting in the open meeting request. 

The Meeting details window opens. 

Click Meeting 

2. Select the Propose New Time button in Meeting 

invitation window. 

The Propose New Time dialog box opens. 

Click Propose New Time 

3. Select a new time. 

The red and green bars in the calendar box move to 

select the next available time slot and the new times 

appear in the Meeting start time and Meeting end 

time boxes. 

Click the AutoPick Next 

button 
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Steps Practice Data 

4. Select the Propose Time button. 

The Propose New Time dialog box closes, and a new 

Message window opens with the list of recipients in 

the To box. 

Click Propose Time 

5. Select the Send button. 

The Message window closes, and the message with 

the proposed new time is sent. 

Click Send 

 

 

11.7 UPDATING A MEETING 

 Concepts 

When you update a meeting, you can change the attendees, time, location, and 

resources for any meeting that you have organised. You cannot change 

information for meetings that you do not organise. 

 

You can change the status of a meeting to recurring; or, if a meeting attendee 

calls to decline a meeting invitation instead of responding via e-mail, you can also 

update the meeting and change the attendee’s status to declined. 

  Steps  

Update a meeting. 

 

Steps Practice Data 

1. Select the Add or Remove Attendees command 

from the Attendees group. 

The Select Attendees and Resources dialog box 

opens. Click  then Add or 

Remove Attendees... 

2. Select a name from the Name list box. 

A name is selected. 

Scroll as necessary and 

click the appropriate name 

from the Name list box 

3. Select Required or Optional. 

The name is added to the Required or Optional list 

box. 

Click Optional  
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Steps Practice Data 

4. Select the OK button. 

The Select Attendees and Resources dialog box 

closes. 

Click  

5. Select the Send Update button. 

The Send Update to Attendees warning box opens, 

prompting you to designate who should receive the 

message. 

Click  Send Update 

6. Select the desired option. 

The appropriate option is selected. 
Click  Send updates 

only to added or deleted 

attendees., if necessary 

7. Select the OK button. 

The Send Update to Attendees warning box and the 

Message window close and an update is sent to the 

appropriate attendees. 

Click  

 

11.8 CANCELLING A MEETING 

 Concepts 

You can cancel a scheduled meeting. When you cancel a meeting that you have 

already created, and to which you have sent invitations, you should always send 

cancellation notices to the meeting attendees. 

 

 

  Steps 

Cancel a meeting. 

Steps Practice Data 

1. Select the meeting you want to delete. 

The meeting is selected. 

Click the meeting 
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Steps Practice Data 

2. Click the Cancel Meeting from the Meeting tab. 

A Microsoft Outlook warning box opens, asking if you 

want to send a notification for the cancelled meeting. 

Click Cancel Meeting 

3. Select the desired notification option. 

The appropriate notification option is selected. Click  Send 

Cancellation 
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11.9 REVIEW EXERCISE 

 
1. Complete the definition: “____________ are activities that do not involve notifying 

other people or scheduling resources.” 
a. Meeting 
b. Appointments 
c. E-mail  
d. Tasks  

 
 

2. Having accepted a meeting invitation, Outlook automatically adds it to your schedule. 
a. True 
b. False 

 
 

3. List four items you can change when you are updating a meeting: 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 
__________________________________________________ 

 

 
4. What must you do if you cancel a meeting in which you have invited other people to? 
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ECDL Syllabus  

Ref ECDL Task Item Location 

1.1.1 Understand the terms: 

Internet, World Wide Web 

(WWW), Uniform Resource 

Locator (URL), hyperlink. 

1.1 Understand 

the Internet 

1.3 Web 

Browsing 

Concepts 

1.1.2 Understand the structure of 

a web address. 
1.4 Understand 

the Structure of a 

Web Address 

1.1.2 Identify common types of 

domains like: geographical, 

organisation (.org, .edu, 

.com, .gov). 

1.4 Understand 

the Structure of a 

Web Address 

1.1.3 Define the term web 

browser. Identify common 

web browsers. 

1.5 Browsing 

1.1.4 Outline different Internet 

activities like: information 

searching, shopping, 

learning, publishing, 

banking, government 

services, entertainment, 

communication. 

1.5 Browsing 

1.2.1 Recognise ways to protect 

yourself when online.  
5.4 Security and 

Safety 

1.2.2 Define the term encryption.  5.5 Encryption 

1.2.3 Identify a secure website: 

https, lock symbol.  
5.6 Secure 

Websites 

1.2.4 Define the term digital 

certificate.  
5.6 Secure 

Websites 

1.2.5 Recognise options for 

controlling internet use like: 

supervision, web browsing 

restrictions, download 

restrictions.  

5.7 Controlling 

Internet Use 

2.1.1 Open a web browsing 

application.  
1.5 Browsing 

2.1.1 Close a web browsing 

application.  
1.5 Browsing 

2.1.2 Enter a URL in the address 

bar and go to the URL. 
2.1 The Address 

Bar 

2.1.3 Refresh a web page.  2.2 Navigation 

Buttons 

   

Ref ECDL Task Item Location 

2.1.3 Stop a web page 

downloading.  
2.2 Navigation 

Buttons 

2.1.4 Activate a hyperlink.  1.3 Web 

Browsing 

Concepts 

2.1.5 Open a web page in a new 

tab. 
2.3 New Tabs 

2.1.6 Open, close tabs, windows.  2.4 Tabbed 

Browsing 

2.1.6 Switch between tabs, 

windows.  
2.4 Tabbed 

Browsing 

2.1.7 Navigate between pages: 

backwards, forwards, home 

page.  

2.2 Navigation 

Buttons 

2.1.8 Show previously visited 

URLs using history.  
2.10 Browsing 

History 

2.1.9 Complete, submit, reset a 

web-based form.  
4.4 Complete, 

Submit, Rest 

a Web Based 

Form 

2.1.10 Use a web tool to translate 

a web page, text.  
4.5 Use a Web 

Tool to Translate 

a Web Page, Text 

2.2.1 Set the web browser home 

page.  
5.1 Home Page 

Settings 

2.2.2 Understand the term pop-

up. 
5.2 Blocking Pop-

Ups 

2.2.2 Allow, block pop-ups.  5.2 Blocking Pop-

Ups 

2.2.3 Understand the term 

cookie.  
5.3 Cookies 

2.2.4 Use available help 

functions.  
1.6 Use Available 

Help Functions 

2.2.5 Display, hide built-in 

toolbars.  
1.7 Display, Hide 

Built-in Toolbars. 

Restore, Minimise 

the Ribbon 

2.2.6 Delete history, temporary 

internet files, saved form 

data.  

2.10 Browsing 

History 
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Ref ECDL Task Item Location 

2.3.1 Add a bookmark / favourite.  2.5 Bookmarks 

2.3.1 Delete a 

bookmark/favourite.  
2.6 Deleting a 

Bookmark 

2.3.2 Show 

bookmarks/favourites.  
2.7 Show 

Bookmarks / 

Favourites 

2.3.3 Create a 

bookmarks/favourites 

folder. 

2.8 Create a 

Bookmark Folder 

2.3.3 Delete a 

bookmarks/favourites 

folder.  

2.9 Deleting a 

Bookmark Folder 

2.3.3 Add web pages to a 

bookmarks/favourites 

folder.  

2.8 Create a 

Bookmark Folder 

2.4.1 Download files to a 

location. 
4.1 Downloading 

Files 

2.4.1 Save files to a location. 4.1 Downloading 

Files 

2.4.2 Copy text, image to another 

location like: document, e-

mail. 

4.2 Copy Text, 

Image, URL to 

Another Location 

like: Document, 

E-mail  

2.4.2 Copy URL from a web page 

to another location like: 

document, e-mail. 

4.2 Copy Text, 

Image, URL to 

Another Location 

like: Document, 

E-mail  

2.4.3 Preview, selection from a 

web page using available 

printing options.  

4.3 Preview, Print 

A Web Page, 

Selection From A 

Web Page Using 

Available Printing 

Options 

2.4.3 Print a web page, selection 

from a web page using 

available printing options.  

4.3 Preview, Print 

A Web Page, 

Selection From A 

Web Page Using 

Available Printing 

Options 

3.1.1 Define the term search 

engine and name some 

common search engines.  

3.1 Search 

Engines 

   

Ref ECDL Task Item Location 

3.1.2 Carry out a search using a 

keyword, phrase.  
3.2 Advanced 

Search 

3.1.3 Refine a search using 

advanced search features 

like: exact phrase, date, 

language, media type.  

3.2 Advanced 

Search 

3.1.4 Search a web-based 

encyclopaedia.  
3.3 Search a 

Web-Based 

Encyclopaedia, 

Dictionary  

3.1.4 Search a web-based 

dictionary.  
3.3 Search a 

Web-Based 

Encyclopaedia, 

Dictionary  

3.2.1 Understand the importance 

of critically evaluating 

online information.  

3.4 Critical 

Evaluation 

3.2.1 Understand the purpose of 

different sites like: 

information, entertainment, 

opinion, sales.  

1.5 Browsing 

3.2.2 Outline factors that 

determine the credibility of 

a website like: author, 

referencing, up-to-date 

content.  

3.4 Critical 

Evaluation 

3.2.3 Recognise the 

appropriateness of online 

information for a particular 

audience.  

3.4 Critical 

Evaluation 

3.3.1 Define the terms copyright, 

intellectual property.  
5.8 Copyright and 

Intellectual 

Property 

3.3.1 Recognise the need to 

acknowledge sources 

and/or seek permission as 

appropriate.  

5.8 Copyright and 

Intellectual 

Property 

3.3.2 Recognise the main data 

protection rights and 

obligations in your country.  

5.9 Data 

Protection 

4.1.1 Understand the concept of 

an online (virtual) 

community.  

6.2 Online 

Communities 

4.1.1 Identify examples like: 

social networking websites, 

internet forums, web 

conferencing, chat, online 

computer games.  

6.2 Online 

Communities 

  
 



s 
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Ref ECDL Task Item Location 

4.1.2 Outline ways that users can 

publish and share content 

online. 

6.3 Publish and 

Share Online 

Content 

4.1.3 Recognise ways to protect 

yourself when using online 

communities.  

6.5 Privacy and 

Security 

4.2.1 Define the term Instant 

Messaging (IM). 
6.1 

Communicating 

Online 

4.2.2 Define the terms short 

message service (SMS), 

multimedia message 

services (MMS). 

6.1 

Communicating 

Online 

4.2.3 Define the term Voice over 

Internet Protocol (VoIP). 
6.1 

Communicating 

Online 

4.2.4 Recognise good practice 

when using electronic 

communication.  

6.4 Good Online 

Communication 

Practice 

4.3.1 Define the term e-mail and 

outline its main uses.  
7.1 What is E-

mail 

4.3.2 Identify the structure of an 

e-mail address. 
7.2 E-mail 

Address and E-

mail Structure 

4.3.3 Be aware of possible 

problems when sending file 

attachments like: file size 

limits, file type restrictions.  

7.3 E-Mail 

Attachments 

4.3.4 Outline the difference 

between the To, Copy (Cc), 

Blind copy (Bcc) fields and 

recognise their appropriate 

use.  

7.2 E-mail 

Address and E-

mail Structure 

4.3.5 Be aware of the possibility 

of receiving fraudulent and 

unsolicited e-mail. Be 

aware of the possibility of 

an e-mail infecting the 

computer.  

7.4 Fraudulent 

and Unsolicited 

E-mail 

4.3.6 Define the term phishing.  7.5 Phishing E-

mails 

5.1.1 Access an e-mail account.  8.1 Access and 

E-mail Account 

   

  
 

Ref ECDL Task Item Location 

5.1.2 Outline the main purpose of 

standard e-mail folders.  
8.6 Using the 

Folder Pane 

5.1.3 Create an e-mail. 8.7 Create an E-

mail 

5.1.4 Enter one or more e-mail 

addresses, distribution list 

in the To field.  

8.7 Create an E-

mail 

5.1.4 Enter one or more e-mail 

addresses distribution list in 

the Copy (Cc) field. 

8.7 Create an E-

mail 

5.1.4 Enter one or more e-mail 

addresses, distribution list 

in the Blind copy (Bcc) field.  

8.7 Create an E-

mail 

5.1.5 Enter an appropriate title in 

the subject field.  
8.7 Create an E-

mail 

5.1.5 Enter text into the body of 

an e-mail.  
8.7 Create an E-

mail 

5.1.5 Paste text into the body of 

an e-mail. 
8.7 Create an E-

mail 

5.1.5 Spell check an e-mail. 8.7 Create an E-

mail 

5.1.6 Add a file attachment.  9.1 Attaching a 

File to a Message 

5.1.6 Remove a file attachment.  9.1 Attaching a 

File to a Message 

5.1.7 Send an e-mail with, 

without priority.  
8.7 Create an E-

mail 

5.2.1 Open an e-mail. 8.9 Opening an 

E-mail Message 

5.2.1 Close an e-mail. 8.9 Opening an 

E-mail Message 

5.2.2 Use the reply, reply to all 

function. 
8.10 Replying to 

a Message 

5.2.2 Identify when the reply, 

reply to all function should 

be used.  

8.10 Replying to 

a Message 

5.2.3 Forward an e-mail.  8.11 Forwarding 

a Message 
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Ref ECDL Task Item Location 

5.2.4 Open, save a file 

attachment to a location.  
9.2 Opening an 

Attachment 

9.3 Saving a File 

Attachment 

5.2.5 Preview a message using 

available printing options.  
8.14 Printing from 

the Message 

Window 

5.2.5 Print a message using 

available printing options.  
8.14 Printing from 

the Message 

Window 

5.3.1 Use available help 

functions.  
8.5 Using 

Microsoft Outlook 

Help 

5.3.2 Restore, minimise the 

ribbon.  
10.3 Working with 

Custom Views  

5.3.3 Create a text e-mail 

signature.  
9.4 Creating a 

Signature 

5.3.3 Insert a text e-mail 

signature.  
9.5 Inserting a 

Signature 

5.3.4 Turn on, turn off an 

automatic out of office 

reply.  

9.6 Using the Out 

of Office 

5.3.5 Recognise e-mail status as 

read, unread. Flag, unflag 

an e-mail. 

8.12 Changing 

the Read Status 

of a Message 

8.13 Flagging a 

Message 

5.3.5 Mark an e-mail as read, 

unread.  
8.12 Changing 

the Read Status 

of a Message 

5.3.5 Flag an e-mail. 8.13 Flagging a 

Message 

5.3.5 Unflag an e-mail. 8.13 Flagging a 

Message 

5.3.6 Create, delete, update a 

contact, distribution 

list/mailing list.  

9.7 Creating a 

Contact Group 

5.3.6 Create a distribution list / 

mailing list.  
9.7 Creating a 

Contact Group 

5.3.6 Delete a contact, 

distribution list / mailing list.  
9.9 Deleting a 

Contact 
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5.3.6 Update a contact, 

distribution list / mailing list.  
9.8 Using a 

Contact Group to 

create message 

5.4.1 Add, remove message 

inbox headings like: sender, 

subject, date received.  

10.3 Working with 

Custom Views  

5.4.2 Search for an e-mail by 

sender, subject.  
10.4 Using 

Search 

5.4.2 Search for an e-mail by e-

mail content.  
10.4 Using 

Search 

5.4.3 Sort e-mails by name, by 

date, by size.  
10.2 Sorting 

Messages 

5.4.4 Create an e-mail 

folder/label. 
10.5 Creating a 

New Folder 

5.4.4 Delete an e-mail 

folder/label. 
10.7 Deleting a 

Folder 

5.4.4 Move e-mails to an e-mail 

folder/label. 
10.6 Moving a 

Message to a 

Different Folder 

5.4.5 Delete an e-mail. 10.8 Deleting a 

Message 

5.4.5 Restore a deleted e-mail. 10.10 Recovering 

Deleted Items 

5.4.6 Empty the e-mail 

bin/deleted items/trash 

folder.  

10.9 Emptying 

the Deleted Items 

Folder 

5.4.7 Move a message to a junk 

folder.  
10.11 Using the 

Junk E-mail 

Folder 

5.4.7 Remove a message from a 

junk folder.  
10.11 Using the 

Junk E-mail 

Folder 

5.5.1 Create a meeting in a 

calendar.  
11.3 Scheduling a 

New Appointment 

5.5.1 Cancel a meeting in a 

calendar.  
11.8 Cancelling a 

Meeting 

5.5.1 Update a meeting in a 

calendar.  
11.7 Update a 

Meeting 

5.5.2 Add invitees, resources to a 

meeting in a calendar.  
11.4 Scheduling a 

Resource for a 

Meeting 
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5.5.2 Remove invitees, resources 

from a meeting in a 

calendar.  

11.4 Scheduling a 

Resource for a 

Meeting 



 

 

 

Congratulations! You have reached the end of the ECDL Online Essentials book. 

You have learned about the key skills relating to key online activities, including: 

 Understand web browsing and online security concepts. 

 Use the web browser and manage browser settings, bookmarks, and web 

outputs. 

 Search effectively for online information and critically evaluate web content. 

 Understand key copyright and data protection issues. 

 Understand concepts of online communities, communications and e-mail. 

 Send, receive e-mails and manage e-mail settings. 

 Organise and search e-mails and use calendars. 

Having reached this stage of your learning, you should now be ready to undertake ECDL 

certification testing. For further information on taking this test, please contact your ECDL 

test centre.  
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